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Overview

VIVOTEK’s CC9380-HV is a vandal-proof fisheye network camera offering up to 20 fps
at 5-Megapixel resolution when the WDR feature is enabled. With its unique design and
inconspicuous appearance, the camera is suitable for a wide array of environments. Featuring
180° horizontal panoramic views with adjustable 25° tilt angle, the camera allows users amazing
flexibility of viewing angles and options. The camera’s weather-proof compact size also makes it
an ideal choice for indoor and outdoor scenarios such as boutiques, convenience stores, banks,
schools, parking lots and residential homes.

The camera provides a view of up to 180 degrees, providing complete video security without
losing angle coverage. Featuring WDR Pro, the camera captures both the dark and bright areas
of an image and combines the differences to create a highly realistic representation of the original
scene. Further, with added SNV technology, high-quality full-color surveillance video becomes
possible even under low-light conditions. These combined features enable the camera to provide
video quality remarkably close to the capabilities of the human eye. Further increasing the level of
surveillance, a built-in microphone can record sound within a 5-meter radius.
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Revision History

m Rev. 1.0: Initial release.

Read Before Use

The use of surveillance devices may be prohibited by law in your country. The Network Camera
is not only a high-performance web-ready camera but can also be part of a flexible surveillance
system. It is the user’s responsibility to ensure that the operation of such devices is legal before
installing this unit for its intended use.

It is important to first verify that all contents received are complete according to the Package
Contents listed below. Take note of the warnings in the Quick Installation Guide before the Network
Camera is installed; then carefully read and follow the instructions in the Installation chapter to
avoid damage due to faulty assembly and installation. This also ensures the product is used
properly as intended.

The Network Camera is a network device and its use should be straightforward for those who
have basic networking knowledge. It is designed for various applications including video sharing,
general security/surveillance, etc. The Configuration chapter suggests ways to best utilize the
Network Camera and ensure proper operations. For creative and professional developers, the URL
Commands of the Network Camera section serves as a helpful reference to customizing existing
homepages or integrating with the current web server.

Package Contents

m CC9380-HV

m Screw pack, IP66 waterproof cable connector, mount adapter bracket, Tilt bracket
m Desiccant bag,

m Quick Installation Guide & alignment sticker

Symbols and Statements in this Document

INFORMATION: provides important messages or advices that might help prevent
inconvenient or problem situations.

NOTE: Notices provide guidance or advices that are related to the functional integrity of
the machine.

1/
1N

Tips: Tips are useful information that helps enhance or facilitae an installation, function,
or process.

WARNING! or IMPORTANT!: These statements indicate situations that can be
dangerous or hazardous to the machine or you.

Electrical Hazard: This statement appears when high voltage electrical hazards might
occur to an operator.

N
N
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Physical Description

RJ45 female connector

LED

Microphone contact pins

Lens & tilt screws

Lens
l
if 1 (T
e
2 spfd
[ d |
[LTT A\
Y
Y
Reset button

MicroSD/SDHC/SDXC

Card Slot
4§ NOTE:
The "T" and "HT" models have an auto-focus motorized lens. Some of the suffix syntax are
listed below:
E w/ heater for extreme weather
Fx Focal length w/ number
T w/ Remote focus lens
R w/ PoE repeater
H w/ High Dynamic Range functionality also known as WDR
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Hardware Installation

A IMPORTANT:

Do not remove the protective sheet before the installation is completed.

1.Jot down the camera's MAC address for later reference. This is especially important if
you install numerous cameras at an installation site.
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2.Use the included sticker for mount holes and drilling a cabling hole. If mounting to a
junction box or tilt bracket is preferred, route a CAT5e or CAT6 Ethernet cable through

the cabling hole.

G 9)
LT Drill hole ----~ “
g 2
CATS
o)
|
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3.Remove the top cover using the included T10 screwdriver.

4.Install a MicroSD card if onboard storage is preferred. Replace the desiccant bag.

=
S
S

>

) ©

N

@ 268 C

=
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5.Install the waterproof connector.
5-1. Insert an Ethernet cable through the cable gland, and the rubber seal.

5-2. Remove part of cable sheath. You will need an RJ45 crimping tool to attach the
Ethernet wires to a connector.

5-3. Connect the RJ45 connector and tighten the waterprorf connector with a rubber seal

within.

o: white/orange stripe
O: orange solid

g: white/green stripe
B: blue solid

b: white/blue stripe
G: green solid

br: white/brown stripe
BR: brown solid

w
2 gOowaeOo
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6. With anchors in the wall, install the camera by driving 4 Phillips screws.

. w
Q. "'
Q. "ﬂ
& Py

7. Install the dome cover.
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|
_‘ “  You can loosen the retention screw on the lens module to tilt the shooting angle
@ if the need should arise.

@B

25° 25°

= 1

ISen ko)
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I
‘@’ You can remove the plastic tab and route cable from the notch on the top.

Chances are you may not be able to drill a cabling hole on the wall. You can
remove the plastic side cap, and route the cable along the wall.

........ "G" -D@D O
o [¢]

1., Through an adapter plate, you can install the camera to a single gang box. .

1-7/8 in. single gang box
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8. Connect the Ethernet cable to a PoE mid-span or switch. Install the Shepherd utility
software so that you can access the camera over the network.

Shepherd
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Software Installation

10. Install the Shepherd utility, which helps you locate and configure your Network Camera
in the local network. If your camera comes without the CD, go to VIVOTEK’s website,
and locate the utility in the Downloads > Software page.

%/VIV@I=K Products  Support Downloads Solutions  L¢

Product Files
Brochure
Firmware
Flyer

Logo

Software I

Wall Paper
SDK

High-Se e

10-1. Run the Shepherd utility.

10-2. The program will conduct an analysis of your network environment.

13 device(s) found &

All devices Selected

Model MAC Firmware

AW-GET-094A-... 192.168.4.123 00-02-D1-2F-B7-3C 0106
spg1e1 192.168.50.4 00-02-D1-30-55-BF 0100g6
FE9181-H 192.168.50.3 00-02-D1-3E-1D-97 010063
129361-EH 192.168.4.148 00-02-D1-43-E6-52 0102f
FDE177-H 192.168.4.147 00-02-D1-4B-F2-1C 0100e_8
SD9366-EHL 192.168.4.105 00-02-D1-4C-FB-EB 0103a
AW-GEU-0B6A-...  192.168.50.1 00-02-D1-4E-D8-14 0001
VAST 169.254.214.242 00-50-56-C0-00-01 1.12.1.8
VAST 192.168.4.113 2C-60-0C-FF-52-9F 1.13.03
VAST 192.168.4.131 2C-60-0C-FF-52-A0 1.12.1.8
VAST 192.168.4.121 34-E6-D7-24-7D-C6 1.13.03

192.168.4.118 54-53-ED-B3-B9-9E 1.13.03
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10-3. The program will search for all VIVOTEK network devices on the same LAN.

10-4.After a brief search, the installer window will prompt. Click on the MAC and model
name that matches the one printed on the product label. You can then double-click on
the address to open a management session with the Network Camera.

% wv@EK 1 selected (©

MAC:0002D1730202 RoHS c E 0 i

|
atus Firmware
(AR FS
CC9380-HV 192.168.4.151 00-02-D1-73-02-02

129361-EH 192.168.4.148 0102f

0002D1730202
FDE177-H 192.168.4.147 0100e_8
5D9366-EHL 192.168.4.105 00-02-D1-4C-FB-EB 01032

VAST 169.254.8.13 00-50-56-C0-00-01 11218
VAST 192.168.4.113 2C-60-0C-FF-52-9F 1.13.03
VAST 192.168.4.131 2C-60-0C-FF-52-A0 11218
VAST 192.168.4.118 54-53-ED-B3-B9-9E 1.13.03

VAST 192.168.4.130 54-A0-50-8B-39-3B 11218

1B8360-W 169.254.205.239 5C-F3-70-36-29-D3 0100b

VAST 169.254.182.143 68-05-CA-1F-8D-10 11218
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Forceful Password Configuration

11-1. The first time you log in to the camera, the firmware will prompt for a password
configuration for security concerns.

Since your camera is used for the first time, there is no password. Enter “root” as the
user name, and nothting for the password.

The server 169.234.203.238 is asking for your user name and
password. The server reports that it is from streaming_server.

Warning: Your user name and password will be sent using basic
authentication on a connection that isn’ t secure.

[ ronot
- [
Remember my credentials

11-2. Enter the combination of alphabetic and numeric characters to fulfill the password
strength. requirement. The default name for the camera administrator is “root”, and
can not be changed.

Y viversk

WUW. vIveTEN. Sam

Language

Configure password

At lzast & characters with no space, one alphabet
character(uppercass or lowercase), and one numeric

character

User name - root

User pG.SS\IWI'd - |'ll.lll.lli.l- | Medium
CDnﬁ"‘n l_lser mssml-d - |.ll.lll.ll..l-| ko |

Enable hitps connection to secure the
cenfiguration for password

*The new password will be applied to all connections

Save Cancel

16 - User's Manual




VIVOTEK

11-3. Some, but not all special ASCII characters are supported: !, $, %, -, ., @, », _, and ~.
You can use them in the password combination.

You have used invalid characters. These characters are valid:A-Z,
A a-z, -9 and 15%-.@"_~

11-4. Another prompt will request for the password you configured. Enter the password and
then you can start configure your camera and see the live view.

The server 169.254.205.23% is asking for your user name and
password. The server reports that it is from streaming_server.

Warning: Your user name and password will be sent using basic
authentication on a connection that isn’ tsecure.

i {::------------I }

Remember my credentials

L= J[ &= |
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LED Definitions

I.'; 1 Steady Red Powered and system booting, or network failed
(w) Red LED off Power off

S Green LED off Network is disconnected

- [2 Steady Red and Green LED blinks every 1 |Connected to network

3, sec.

';-;- 3 Green LED blinks every 1 sec. and RED Upgrading firmware

% LED blinks consecutively every 0.15 sec.

4 Green and RED blink every 0.15 sec, Green [Restoring defaults
and RED light on, then blink again.

5 RED LED is on, Green LED blinks and RED |Status after a reset (network connected)
LED is constantly on.
Green and RED LEDs are constantly on. Status after a reset (network disconnected)

Hardware Reset

The reset button is used to reset the system or restore the factory default settings.
Sometimes resetting the system can return the camera to normal operation. If the system
problems remain after reset, restore the factory settings and install again.

Reset: Press the recessed reset button. Wait for the Network Camera to reboot.

Restore: Press and hold the reset button until the status LED rapidly blinks. Note that all
settings will be restored to factory default. Upon successful restore, the status LED will
blink green and red during normal operation.

SD/SDHC/SDXC Card Capacity

This network camera is compliant with SD/SDHC/SDXC 16GB / 8GB / 32GB / 64GB and
other preceding standard SD cards.
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Network Deployment

General Connection (PoE)

(© When using a PoE switch

The Network Camera is PoE-compliant, allowing transmission of power and data via a sin-
gle Ethernet cable. Follow the illustration below to connect the Network Camera to a PoE
switch via an Ethernet cable.

802.3af

PoE Switch

o When using a non-PoE switch

Use a PoE power injector (optional) to connect between the Network Camera and a non-
PoE switch.

Ly,

m =l

PoE Power Injector
(optional)

-

Non-PoE Switch

{J NOTE:

1. The camera is only to be connected to PoE networks without routing to outside plants.
2. For PoE connection, use only UL listed |.T.E. with PoE output.
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Intern nnection vi r r

Before configuring the Network Camera over the Internet, make sure you have a router and
follow the steps below.

1. Connect your Network Camera behind a router, the Internet environment is illustrated below.

Regarding how to obtain your IP address, please refer to Software Installation on page 18 for
details.

WAN (Wide Area Network ) /

Router IP address : from ISP, IP address : 192.168.0.3
Subnet mask : 255.255.255.0
Default router : 192.168.0.1

Internet

LAN (Local Area Network)
Router IP address : 192.168.0.1

- &

IP address : 192.168.0.2
Subnet mask : 255.255.255.0
Default router : 192.168.0.1

Cable or DSL Modem

2. In this case, if the Local Area Network (LAN) IP address of your Network Camera is
192.168.0.3, please forward the following ports for the Network Camera on the router.

m HTTP port: default is 80

m RTSP port: default is 554

m RTP port for video: default is 5556
m RTCP port for video: default is 5557

If you have changed the port numbers on the Network page, please open the ports
accordingly on your router. For information on how to forward ports on the router, please refer
to your router’s user’s manual.

3. Find out the public IP address of your router provided by your ISP (Internet Service Provider).
Use the public IP and the secondary HTTP port to access the Network Camera from the
Internet. Please refer to Network Type on page 77 for details.

Internet connection with static IP

Choose this connection type if you are required to use a static IP for the Network Camera.
Please refer to LAN setting on page 76 for details.

Intern nnection via PPPoE (Point-to-Point over Ethern

Choose this connection type if you are connected to the Internet via a DSL Line. Please refer to
PPPoE on page 77 for details.
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Configure the router, virtual server or firewall, so that the router can forward any data com-
ing into a preconfigured port number to a network camera on the private network, and
allow data from the camera to be transmitted to the outside of the network over the same
path.

From Forward to
122.146.57.120:8000 [192.168.2.10:80
122.146.57.120:8001  [192.168.2.11:80

When properly configured, you can access a camera behind the router using the HTTP
request such as: http://122.146.57.120:8000

If you change the port numbers on the Network configuration page, please open the ports
accordingly on your router. For example, you can open a management session with your
router to configure access through the router to the camera within your local network.
Please consult your network administrator for router configuration if you have troubles with
the configuration.

For more information with network configuration options (such as that of streaming ports),
please refer to Configuration > Network Settings. VIVOTEK also provides the automatic
port forwarding feature as an NAT traversal function with the precondition that your router
must support the UPnP port forwarding feature.

Metwork = General settings

System

Media

i LAM

Heterork & Get P address automaticaly

General seftings O Use Bxed P addness

Streamang profecols [#] Enabie UPsP presentation

DONS I [#] Enable UPsS port ferwarding I

(4719 i PPPGE

SHMP [# Enable PvE
- The devics is configurng now. Yeer Browser will econnect
Security 1BwE informng  fo hHpotIS2 1684, 180:80¢
PTZ EIH“W mmmmhm,

(—— | BTN
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Ready to Use

1.A browser session with the Network Camera should prompt as shown below.

2.You should be able to see live video from your camera. You may also install the 32-channel
recording software from the software CD in a deployment consisting of multiple cameras. For
its installation details, please refer to its related documents.

% viversk CC9381-HV

Video stream: [1 [ v] T Client settings | Configuration | Language

# Manual triggers:

A
sk
V]
(= Zoom
[_Pan [ stp [ Patrol |
Pan speed: |o .
Tilt speed: |o .v

Zoom speed: |0

= Global view:

Move Instantly

poveered by ¥ vivoTeK @ @ @ @ @ Go to I-— Select one --.
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Accessing the Network Camera

This chapter explains how to access the Network Camera through web browsers, RTSP players,
3GPP-compatible mobile devices, and VIVOTEK recording software.

Using Web Browsers

Use the Shepherd utility to access the Network Cameras on LAN.

If your network environment is not a LAN, follow these steps to access the Netwotk Camera:

1. Launch your web browser (e.g., Microsoft® Internet Explorer or Mozilla Firefox).

2. Enter the IP address of the Network Camera in the address field. Press Enter.

3. Live video will be displayed in your web browser.

4. If it is the first time installing the VIVOTEK network camera, an information bar will prompt as
shown below. Follow the instructions to install the required plug-in on your computer.

3 Network Camera - Microsoft Internet Explorer

to E& Viw Fovrkes Toos Fdb
Qo - © X [ @ Psewer Soroons @ R 2 [ B 77 -] [G[cense
adivess | €] hetpuif152.168.5.151] B> ERTT
; ontrof from VIVOTEK INC.". Click here to install,.. x
a
Mega-Pixel Network Camera
This is & plug-in (ActiveX). If you see this text, your browser is not support or disable ActiveX.
(oj[@l[u][s][o][x]w] [ ¥]c
EEHEEA 4
sl — [ zoom [ +]
L Fo [ ey [ra]
Panspeed 0+
10 ot o s mssage ge Titspeed 0 -
Panspeed: 0 Zoom speed:
Titspeed: 0 < Lean sbout the Infomalion Bar.. » Globalview:
Zoom speed:
# Global view:
e e o rtaltross pi.
£
v
@ oone ] ] @ temet Do

§) NOTE:

» For Mozilla Firefox or Chrome users, your browser will use QuickTime to stream the live
video. If you don’t have QuickTime on your computer, please download it first, then launch
the web browser.

) Network Camera - Mozilla Firefox

Bl Edt Vew Hstory Bookmarks ook Hep () Bl Edt Vew Fgoy B Tooks b B
O - ¢ x o (Olwizessimenm 7 -] [G e P2 O - ¢ % o (Olrimsmes s % <] [G[ceose 2
Do you wank Frefos to remember this password? Never for Thisste ] [tiottow | 3 T e — [veverorizse | [netnon | &

Mega-Pixel Network Camera g:ww"@'ﬁ!(m Mega-Pixel Network Camera

Client settings | Configuration | Language.

................... "0 0@@O e - et s

v
= 7 o o
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» By default, the Network Camera is not password-protected. To prevent unauthorized access,

it is highly recommended to set a password for the Network Camera.
For more information about how to enable password protection, please refer to Security on

page 94.

» If you see a dialog box indicating that your security settings prohibit running ActiveX®
Controls, please enable the ActiveX® Controls for your browser.

1. Choose Tools > Internet Options > Security > Custom Level.

Internet Options

General | Security | Privacy " Eontent" Connections " Frograms " Advanced]

Select a'web content zone to specify itz security settings.

® © 0 @

Localintranet  Trusted sites  Restricted
gihes

Internet

Thiz zohe containg all'web sites you Sl

haven't placed in ather zones .
Security level for this zone

Custom

Cusztom zettings.
- To chahge the settings, click Customn Level.
- Ta use the recommended settings, click Default Level

[ Eustomly Default Level ]

i kK i[ Cancel J| Apply |

2. Look for Download signed ActiveX® controls; select Enable or Prompt. Click OK.

Security Settings

Setkings:

Activer controls and plug-ins
] Download signed Activel controls

Disable
Enable
@) Prompk

] Dowwrload unsigned Ackiver contrals

Disable
Enable
Promnpk

. Initialize and scripk ActiveX controls nok marked as safe

Disable

Enable

F‘rom I: n
" L]

LT bmle e d e i m

Reset cuskom setkings

Reset ko |Medium |f;|[ Resst J

i K i[ Cancel J

3. Refresh your web browser, then install the ActiveX® control. Follow the instructions to
complete installation.
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A IMPORTANT:

Currently the Network Camera utilizes 32-bit ActiveX plugin. You CAN NOT open a
management/view session with the camera using a 64-bit IE browser.

If you encounter this problem, try execute the lexplore.exe program from C:\Windows\
SysWOW64. A 32-bit version of IE browser will be installed.
On Windows 7, the 32-bit explorer browser can be accessed from here:

C:\Program Files (x86)\Internet Explorer\iexplore.exe

If you open a web session from the IW2 utility, a 32-bit IE browser will be opened.

-‘@'- Tips:

1. The onscreen Java control can malfunction under the following situations: A PC con-
nects to different cameras that are using the same IP address (or the same camera
running different firmware versions). Removing your browser cookies will solve this
problem.

2. If you encounter problems with displaying the configuration menus or Ul items, try dis-
able the Compatibility View on IE8 or IE9.

) JB http://www joinsmsn.com/ D-\2iex

You may also press the F12 key to open the developer tools utility, and then change the
Browser Mode to the genuine IE8 or IE9 mode.

File Find Disable View Images Cache Tools \r’alidaie| CIETEEAN LR Document Mode: [E9 standards =

HTML | S5 Console Script Profiler Netwark Internet Explorer 7 P

[} R i 4 H = Internet Explorer &

-~ <IDOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.8 -
-<html xmlns="http://www. 71999/ xhtml"> Internet Explorer 3 Compatibility View

v Internet Explorer 9 S——

* In the event of plug-in compatibility issues, you may try to uninstall the plug-in that was
previously installed.

| Business Explorer

| Camera Stream Contraller
2+ Uninstall

;M Catalyst Control Center

am
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Using RTSP Players

To view the streaming media using RTSP players, you can use one of the following players that
support RTSP streaming.

Q QuickTime Player
A VLC media player

1. Launch the RTSP player.

2. Choose File > Open URL. A URL dialog box will pop up.

3. The address format is rtsp://<ip address>:<rtsp port>/<RTSP streaming access name for
stream1 or stream2>

As most ISPs and players only allow RTSP streaming through port number 554, please set the
RTSP port to 554. For more information, please refer to RTSP Streaming on page 84.
For example:

Enter an Intermet LIRL to open:

rtsp:/192.1685.151}554/live.sdp | ~]

i ak i[ Cancel J

4. The live video will be displayed in your player.
For more information on how to configure the RTSP access name, please refer to RTSP
Streaming on page 84 for details.
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Using 3GPP-compatible Mobile Devices

To view the streaming media through 3GPP-compatible mobile devices, make sure the Network
Camera can be accessed over the Internet. For more information on how to set up the Network
Camera over the Internet, please refer to Setup the Network Camera over the Internet on page

18.

To utilize this feature, please check the following settings on your Network Camera:

1. Because most players on 3GPP mobile phones do not support RTSP authentication, make
sure the authentication mode of RTSP streaming is set to disable.
For more information, please refer to RTSP Streaming on page 84.

2. As the the bandwidth on 3G networks is limited, you will not be able to use a large video size.

Please set the video streaming parameters as listed below.
For more information, please refer to Stream settings on page 67.

Video Mode T H.264
Frame size T 176 x 144
Maximum frame rate ~~ 5fps
Intra frame period 1S

Video quality (Constant bit rate) ~ 40kbps

3. As most ISPs and players only allow RTSP streaming through port number 554, please set
the RTSP port to 554. For more information, please refer to RTSP Streaming on page 84.

4. Launch the player on the 3GPP-compatible mobile devices (e.g., QuickTime).

5. Type the following URL commands into the player.
The address format is rtsp://<public ip address of your camera>:<rtsp port>/<RTSP streaming

access name for stream # with small frame size and frame rate>.
For example:

Open URL

Enter an Internet URL to open:
[rtsp://132.168 4.147.654/lived sdp |

You can configure Stream #2 into the suggested stream settings as listed above for live
viewing on a mobile device.
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Using VIVOTEK Recording Software

The product software CD also contains a VAST recording software, allowing simultaneous
monitoring and video recording for multiple Network Cameras. Please install the recording
software; then launch the program to add the Network Camera to the Channel list. For detailed
information about how to use the recording software, please refer to the user’s manual of the
software or download it from http://www.vivotek.com.

(__System | Edit | View | Configuration | Layout | Help |

(0] 60 o] &) o fealEH [T ] 5]E[®)

= B v _station1(127.0.0.1)
= B camera
# (w1 _IP7161(192.168.3.136)
+ @w 2_07161(192.168.3.136)
+ B 3P7161(192.168.3.136)
@ 4_IPB161(192.168.3.152)

PTZ  Two Way Audio | Tnstant Playhack
Activate mode: |Mecharicd v

= (=) = ]
C ) )
[SE{==rr="E
Treom

-‘@’- Tips:

1. If you forget the root (administrator) password for the camera, you can restore the camera
defaults by pressing the reset button for longer than 5 seconds.

2. If DHCP is enabled in your network, and the camera cannot be accessed, run the IW2 utility
to search the network. If the camera has been configured with fixed IP that does not comply
with your local network, you may see its default IP 169.254.x.x. If you still cannot find the
camera, you can restore the camera to its factory defaults.

3. If you change your network parameters, e.g., added a camera via a connection to a LAN
card, re-start the Shepherd utility.


http://www.vivotek.com

VIVOTEK

Main Page

This chapter explains the layout of the main page. It is composed of the following sections:
VIVOTEK INC. Logo, Host Name, Camera Control Area, Configuration Area, Menu, and Live
Video Window.

Resize Buttons

VIVOTEK INC.
Logo S CC9381-HV Host Name
Video stream: [ [] . Configuration
# Manual triggers: Area
EEI
Camera Control | mm——
Area (e L smp [raol]
Pan speed
Tilt speed
Zoom speed: |0

Move Instantly

— Live View Window

a/g)n](s](o][][W][E] cowlsmmme-r]

VIVOTEK INC. Logo
Click this logo to visit the VIVOTEK website.

Host Name
The host name can be customized to fit your needs. The name can be changed especially there are many
cameras in your surveillance deployment. For more information, please refer to System on page 44.

Camera Control Area

Video Stream: This Network Camera supports multiple streams (streams 1 and 2) simultaneously. You
can select any of them for live viewing. For more information about multiple streams, please refer to page
67 for detailed information.

Manual Trigger: Click to enable/disable an event trigger manually. Please configure an event setting on
the Application page before you enable this function. A total of 3 event configuration can be configured.
For more information about event setting, please refer to page 111. If you want to hide this item on
the homepage, please go to Configuration> System > Homepage Layout > General settings >
Customized button to deselect the “show manual trigger button” checkbox.
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Configuration Area

Client Settings: Click this button to access the client setting page. For more information, please refer to
Client Settings on page 38.

Configuration: Click this button to access the configuration page of the Network Camera. It is suggested
that a password be applied to the Network Camera so that only the administrator can configure the
Network Camera. For more information, please refer to Configuration on page 43.

Language: Click this button to choose a language for the user interface. Language options are available

in: English, Deutsch, Espafiol, Frangais, Italiano, P # %, Portugués, f§ + ¥ <, and %% * <. Please
note that you can also change a language on the Configuration page; please refer to page 43.

Hide Button
You can click the hide button to hide or display the control panel.

Resize Buttons

EmELNEEREES]

Click the Auto button, the video cell will resize automatically to fit the monitor.
Click 100% is to display the original homepage size.

Click 50% is to resize the homepage to 50% of its original size.

Click 25% is to resize the homepage to 25% of its original size.

Live Video Window

m The following window is displayed when the video mode is set to H.264:
H.264 Protocol and Media Options

Video Title | vided (TPC-AV)| 2017/03/25 17:08:56 Time
Title and Time Video 17:08:56 2017/03/25
Zoom Indicator
-seectone-[v| —— \/ideo Control Buttons

Video Title: The video title can be configured. For more information, please refer to Video Settings on
page 56.

H.264 Protocol and Media Options: The transmission protocol and media options for H.264 video
streaming. For further configuration, please refer to Client Settings on page 38.

Time: Display the current time. For further configuration, please refer to Media > Image > Genral settings
on page 56.

Title and Time: The video title and time can be stamped on the streaming video. For further configuration,
please refer to Media > Image > General settings on page 60.
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PTZ Panel: This Network Camera supports “digital“ (e-PTZ) pan/tilt/zoom control, which allows roaming
a smaller view frame within a large view frame. Please refer to PTZ settiings on page 108 for detailed
information.

Global View: Click on this item to display the Global View window. The Global View window contains a

full view image (the largest frame size of the captured video) and a floating frame (the viewing region of
the current video stream). The floating frame allows users to control the e-PTZ function (Electronic Pan/
Tilt/Zoom). For more information about e-PTZ operation, please refer to E-PTZ Operation on page 108.
For more information about how to set up the viewing region of the current video stream, please refer to
page 108.

The viewing region of
the curruent video
stream

The largest frame size

[¥] Maoving Instantly

Note that the PTZ buttons on the panel are not operational unless you are showing only a portion of the
full image. If the live view window is displaying the full view, the PTZ buttons are not functional.
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Video Control Buttons: Depending on the Network Camera model and Network Camera configuration,
some buttons may not be available.

@ Snapshot: Click this button to capture and save still images. The captured images will be displayed
in a pop-up window. Right-click the image and choose Save Picture As to save it in JPEG (*.jpg) or BMP
(*.bmp) format.

Digital Zoom: Click and uncheck “Disable digital zoom” to enable the zoom operation. The navigation
screen indicates the part of the image being magnified. To control the zoom level, drag the slider bar. To
move to a different area you want to magnify, drag the navigation screen.

Disable digital ptz

Zoom Factor: 1007, =
L(F

- 100% 400%
I

@ Pause: Pause the transmission of the streaming media. The button becomes the |E| Resume button
after clicking the Pause button.

E Stop: Stop the transmission of the streaming media. Click the E Resume button to continue
transmission.

IZI Start MP4 Recording: Click this button to record video clips in MP4 file format to your computer.

Press the E Stop MP4 Recording button to end recording. When you exit the web browser, video
recording stops accordingly. To specify the storage destination and file name, please refer to MP4 Saving

Options on page 39 for details.

@ Volume: When the Mute function is not activated, move the slider bar to adjust the volume on the
local computer.

Mute: Turn off the volume on the local computer. The button becomes the E Audio On button after
clicking the Mute button.

Full Screen: Click this button to switch to full screen mode. Press the “Esc” key to switch back to normal
mode.

@ NOTE:

1. For a megapixel camera, it is recommended to use monitors of the 24" size or larger, and
are capable of 1600x1200 or better resolutions.
2. Below are the defaults for Audio settings:
For cameras with built-in microphone: Not Muted.
For cameras without built-in microphone: Muted.

To receive audio input from an external microphone, you may need to enable the audio input
from Media > Audio. Refer to page 75 for more information.
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m The following window is displayed when the video mode is set to MJPEG:

Video Title | Video|(HTTP-V)
Title and Time Video 17:08:56 2015/07/2

Video Control Buttons

Video Title: The video title can be configured. For more information, please refer to Media > Image on
page 60.

Time: Display the current time. For more information, please refer to Media > Image on page 60.

Title and Time: Video title and time can be stamped on the streaming video. For more information, please
refer to Media > Image on page 60.

Video Control Buttons: Depending on the Network Camera model and Network Camera configuration,
some buttons may not be available.

@ Snapshot: Click this button to capture and save still images. The captured images will be displayed
in a pop-up window. Right-click the image and choose Save Picture As to save it in JPEG (*.jpg) or BMP
(*.bmp) format.

@ Digital Zoom: Click and uncheck “Disable digital zoom” to enable the zoom operation. The navigation
screen indicates the part of the image being magnified. To control the zoom level, drag the slider bar. To
move to a different area you want to magnify, drag the navigation screen.

[C] Disable digital ptz

Zoom Factor:

C A

. 100% 400%
I

E Start MP4 Recording: Click this button to record video clips in MP4 file format to your computer.
Press the Stop MP4 Recording button to end recording. When you exit the web browser, video
recording stops accordingly. To specify the storage destination and file name, please refer to MP4 Saving
Options on page 39 for details.

@ Full Screen: Click this button to switch to full screen mode. Press the “Esc” key to switch back to normal
mode.



VIVOTEK

Client Settings

This chapter explains how to select the stream transmission mode and saving options on the
local computer. When completed with the settings on this page, click Save on the page bottom
to enable the settings.

H.265/.264 Media Options

| Video and audio|

|7 H.265/H.264 media options

Select to stream video or audio data or both. This is enabled only when the video mode is set to H.264.

H.265/.264 Protocol Options

’7 H.265/H.264 protocol options

TCP

Depending on your network environment, there are four transmission modes of H.264 streaming:

UDP unicast: This protocol allows for more real-time audio and video streams. However, network
packets may be lost due to network burst traffic and images may be broken. Activate UDP connection
when occasions require time-sensitive responses and the video quality is less important. Note that each
unicast client connecting to the server takes up additional bandwidth and the Network Camera allows up
to ten simultaneous accesses.

UDP multicast: This protocol allows multicast-enabled routers to forward network packets to all clients
requesting streaming media. This helps to reduce the network transmission load of the Network Camera
while serving multiple clients at the same time. Note that to utilize this feature, the Network Camera must
be configured to enable multicast streaming at the same time. For more information, please refer to
RTSP Streaming on page 84.

TCP: This protocol guarantees the complete delivery of streaming data and thus provides better video
quality. The downside of this protocol is that its real-time effect is not as good as that of the UDP protocol.

HTTP: This protocol allows the same quality as TCP protocol without needing to open specific ports for
streaming under some network environments. Users inside a firewall can utilize this protocol to allow
streaming data through.
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MP4 Saving Options

— MP4 saving options

Folder: | C\Record | | Browse...

File name prefix | CLIP |

Add date and fime suffixto file name

Users can record live video as they are watching it by clicking IZ] Start MP4 Recording on the main
page. Here, you can specify the storage destination and file name.

Folder: Specify a storage destination on your PC for the recorded video files. The location can be
changed.

File name prefix: Enter the text that will be appended to the front of the video file name. A specified folder
will be automatically created on your local hard disk.

Add date and time suffix to the file name: Select this option to append the date and time to the end of the
file name.

CLIP_20200321-180853

tt

File name prefix Date and time suffix
The format is: YYYYMMDD_HHMMSS

Local Streaming Buffer Time

|' Local streaming buffer time

ElMillisecond

Due to the unsteady bandwidth flow, the live streaming may lag and not be very smoothly. If you enable
this option, the live streaming will be stored temporarily on your PC’s cache memory for a few seconds
before being played on the live viewing window. This will help you see the streaming more smoothly. If
you enter 3,000 Millisecond, the streaming will delay for 3 seconds.
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Joystick settings

Enable Joystick
Connect a joystick to a USB port on your management computer. Supported by the plug-in
(Microsoft’s DirectX), once the plug-in for the web console is loaded, it will automatically detect if
there is any joystick on the computer. The joystick should work properly without installing any other
driver or software.

Then you can begin to configure the joystick settings of connected devices. Please follow the
instructions below to enable joystick settings.

1. Select a detected joystick, if there are multiple, from the Selected joystick menu. If your joystick
is not detected, if may be defective.

2. Click Calibrate or Configure buttons to configure the joystick-related settings.

Joystick settings

Selected joystick: | Iacally air

Stick || |

( Calibrate | [ Configure buttons |

@ NOTE:

* If you want to assign Preset actions to your joystick, the preset locations should be configured in
advance in the Configuration > PTZ page.

* If your joystick is not working properly, it may need to be calibrated. Click the Calibrate button
to open the Game Controllers window located in Microsoft Windows control panel and follow the
instructions for trouble shooting. Use the Search panel on the Start menu to search for “Game
Controller.”

* The joystick will appear in the Game Controllers list in the Windows Control panel. If you want to
check out for your devices, go to the following page: Start -> Control Panel -> Game Controllers.

Game Controllers

These zettings help you configure the game controllers installed on
Your cornputer.

Inztalled game contrallers

Controller | Status |
CH PRODUCTS IF DESKTOF CONTROLLER

[ Add... ] [ Femaove ] [ Properties ]

[ Advanced... ][ Troublezhoot, . J
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Buttons Configuration

In the Button Configuration window, the left column shows the actions you can assign, and the right
column shows the functional buttons and assigned actions. The number of buttons may differ from

different joysticks.

Please follow the steps below to configure your joystick buttons:

1. Choosing one of the actions and click Assign will pop up a dialog. Then you can assign this
action to a button by pressing the joystick button or select it from the drop-down list.
For example: Assign Home (move to home position) to Button 1.

“ Buttons Configuration

k3

Assigned Actions
|f-‘u:ticuns | |Elutt|:|n5 Iﬂuﬁsigned Actions |
l.. Home ' A |Button1
oo In i Hutton
- Zoarm Cut
*-FocLs
[+ Tris
- Pan Press the joystick button to assign to "Home" or
- Stop select the button from the list below.
- Patral
[+ Preset
~Page Up
- Page Down BUtrons
- Record ta AWI Buttona
- Shapshot Auto Marming Buttonsd
e Buttons
([Cassn ) | coar solrten | 220508
Euttons ok | [ cancel |
| |Buttong
Buttonlo oK | | Cancel
Buttonll
Buttonlz2

2. Click OK to confirm the configuration.

v Buttons Configuration

Aszigned Actions

- 2oom In
—Zoom Out ) Press the joyvstick button to assign to "Home" or
- Focus select the button from the list below,
[+ Iri=
~Pan ERE
- Patral
= Presat Click "Ok" to assign "" to buttonl
- Preset]
----- Presetd
----- Presetd
..... 2]
ErESEt, (04 Cancel
[ Assign J I Clear Selected J
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Buttons Configuration

Click the Configure Buttons button, a window will prompt as shown below. Please follow the steps
below to configure your joystick buttons:
1. Select a button number from the Button # pull-down menu.

— : 1
] i | -‘@’- Tips:
>Joystick Settings

If you are not sure of the locations of each
Actions: | Toggle playipause  [~] button, use the Properties window in the Game
Assign | | Controllers utility.
Button: |1 [« Delete
1
Button |3 Assigned Actions e e s s e oy
1 ; Full Screen I ;:f;ﬁmgf help you configure the game cantiollers installed on -
2 G Stop Installed game cortralers ——————————————————————
7 Controller [ Status
3 8 Zoom il"l Macally ArStick aK
4 9 HKhsis /Y Bais Shd.
10 Buttor Point of View Hat
: ol lpa:ml 000006000
oggle play/pause Add. | Remowe | Propeies | oOD®® @
S
Advanced.. Troubleshoot,
a
a o |
10 | oK el | o |
11
12 Snapshot
@ R | BEBOT W %> oo - |

2. Select a corresponding action, such as Patrol or Preset#.

3. Click the Assign button to assign an action
to the button. You can delete an association
by selecting a button number, and then click
the Delete button.

>Joystick Settings

| Actions:|Toggle playipause - i i
Repeat the process until you are done with

the configuration of all preferred actions.

Stop streaming

Button: [Snapshot

Full Screen

Start/stop recording
Pan

Button | irol

1 Stop

Zoom in

Zoom out

Digital output on/off 1

Digital output on/off 2

Digital output on/off 3

Digital output on/off 4

Manual trigger on/off 1

Manual trigger on/off 2

Manual trigger onl/off 3

Preset 1

Preset2

Preset3

Presetd

Presets

Preset&

Preset7 -

Presetd

Presetd

Preset 10

Preset 11

Preset 12

Preset 13 -

The buttons you define should appear on the
button list accordingly.

4. Please remember to click the Save button
on the Client settings page to preserve your
settings.

[£= T = - T TR = FI & R O I

T
1

-
5]
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Configuration

Click Configuration on the main page to enter the camera setting pages. Note that only
Administrators can access the configuration page.

VIVOTEK provides an easy-to-use user interface that helps you set up your network camera
with minimal effort. In order to simplify the user interface, detailed information will be hidden
unless you click on the function item. When you click on the first sub-item, the detailed
information for the first sub-item will be displayed; when you click on the second sub-item, the
detailed information for the second sub-item will be displayed and that of the first sub-item will
be hidden.

The following is the interface of the main page:

W VIV ST e S m Home Client settings ESGIMIEGLLE Language

System = General settings

System . i
: ~ System Navigation Area

General settings Host name: |Mega-Pixel Netwaork Camera |

Homepage ut
= Turn off the LED indicator

Logs

— System time

Time zone: | GMT+08:00 Beiiing, Chongging, Hong Kong, Kuala Lumpur, Singapore, TaipeiI;H

Media Mote: ou can upload your daylight saving time rules on Maintenance page or use the camera default
value.

MNetwork
@ Keep current date and time

Security @ Synchronize with computer time
PTZ © Manual

@ Automatic
Event

Applications . . .
oP Configuration List

Recording

Local storage

Firmware Version

Each function on the configuration list will be explained in the following sections.

The Navigation Area provides access to all different views from the Home page (for live viewing),
Configuration page, and multi-language selection.
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System > General settings

This section explains how to configure the basic settings for the Network Camera, such as the
host name and system time. It is composed of the following two columns: System, and System
Time. When finished with the settings on this page, click Save at the bottom of the page to
enable the settings.

System

System

Host name: Mega-Pixel Network Camera

[ 'Tum off the LED indicator

Host name: Enter a desired name for the Network Camera. The text will be displayed at the top of the
main page, and also on the view cells of the ST7501 and VAST management software.

Turn off the LED indicators: If you do not want others to notice the network camera is in operation, you
can select this option to turn off the LED indicators.
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System time

— System time

Time zone: GMT+08:00 Beiiing, Chonaaina, Hona Kona. Kuala Lumeur, Singapore, Taipei E||

Mote: You can upload your daylight saving time rules on Maintenance page or use the camera
default value.

@ Keep current date and time
(7 8ynchronize with computer time
) Manual

) Automatic

Keep current date and time: Select this option to preserve the current date and time of the Network
Camera. The Network Camera’s internal real-time clock maintains the date and time even when the
power of the system is turned off.

Synchronize with computer time: Select this option to synchronize the date and time of the Network
Camera with the local computer. The read-only date and time of the PC is displayed as updated.

Manual: The administrator can enter the date and time manually. Note that the date and time format are
[yyyy/mm/dd] and [hh:mm:ss].

Automatic: The Network Time Protocol is a protocol which synchronizes computer clocks by periodically
querying an NTP Server.

NTP server: Assign the IP address or domain name of the time-server. Leaving the text box blank
connects the Network Camera to the default time servers. The precondition is that the camera must
have the access to the Internet.

Update interval: Select to update the time using the NTP server on an hourly, daily, weekly, or monthly
basis.

Time zone : Select the appropriate time zone from the list. If you want to upload Daylight Savings Time
rules, please refer to System > Maintenance > Import/ Export files on page 53 for details.

User's Manual - 41




VIVOTEK

System > Homepage layout

This section explains how to set up your own customized homepage layout.

General settings

This column shows the settings of your hompage layout. You can manually select the background and
font colors in Theme Options (the second tab on this page). The settings will be displayed automatically
in this Preview field. The following shows the homepage using the default settings:

| General settings ” Theme options |

®VIVOTEK  Mega-Pixel Network

]
WML, VWivo TEN,. S m

Viideo stream
= Manual triggers:

Digital cutput:

-

eI Eal S

Povvered by z’fvlmn
|
|

Hide Powered by VIVOTEK
m Hide Powered by VIVOTEK: If you check this item, it will be removed from the homepage.

Logo graph
Here you can change the logo that is placed at the top of your homepage.

— Logo graph

Acustomized logo (Gif, JPG or PMNG) can be uploaded for main page. twill be resized to
160x50 pixels to replace the previous logo.

™ Default * Custom

%/ =K I rowse |
WL VI Ve T E . = am Upload |

Logo link: ‘ hitp:ifwaen vivatek.com ‘

Follow the steps below to upload a new logo:

1. Click Custom and the Browse field will appear.

2. Select a logo from your files.

3. Click Upload to replace the existing logo with a new one.
4. Enter a website link if necessary.

5. Click Save to enable the settings.

Customized button
If you want to hide manual trigger buttons on the homepage, please uncheck this item. This item is

checked by default.

Customized button

Show manual trigger button
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Theme Options

Here you can change the color of your homepage layout. There are three types of preset patterns for you

to choose from. The new layout will simultaneously appear in the Preview filed. Click Save to enable the
settings.

| General settings || Theme options |

Y VIVOIEK  Mega-Pixel Network Font Color of the
A Video Title
Font Color I“‘d‘*" D I
3ackground Color of the ¥ Manual triggers:
Sontrol Area Digital output:

Font Color of
the Configuration Area

Background Color of
the Video Area

Frame Color

ackground Color of the
onfiguration Area

— Themes ——————— — Color

Font color:

Font color of video title: -

Bk color of control area: #CAEAFF

|| Bk color of configuration area: -
Bk color of video area: H#CAEAFF

) Custom

Preset patterns

€]

o
u

| General settings || Theme options |

CVIVOTEK  Mega-Pixel Network

WWW, vIive TEN. =2 m

Video stream

= Manual triggers:

Digital output:

Fowered by % yivETER

Y VIVeTEK  Mega-Pixel Network

W VIV TEN. S0

Video stream
Manual triggers:

Digital output: [EE

e MmO e L P =

d by ¥ viversk
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m Follow the steps below to set up the customed homepage:
1. Click Custom on the left column.
2. Click the field where you want to change the color on the right column.

— Themes ———— — Color
Font color:
® H Font color of configuration area: #FFFFFF
Color Selector
Font color of video title:
© - Bk color of control area:
- Bk color of configuration area:
- -. Bk color of video area:
Custom | ®  Custom | Frame color:
Pattern

3. The palette window will pop up as shown below.

Red: ICI Red: E
Green: ICI Green: E
Blue: I:I Blue: E
Hue: ICI Hue: E
Saturation: I:I Saturation: IE
Walue: ICI Yalue: 541

4. Drag the slider bar and click on the left square to select a desired color.
5. The selected color will be displayed in the corresponding fields and in the Preview column.
6. Click Save to enable the settings.
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System > Logs

This section explains how to configure the Network Camera to send the system log to a remote
server as backup.

Log server settings

Log server settings

¥l Enable remote log

port: 514

Follow the steps below to set up the remote log:

1. Select Enable remote log.

2. In the IP address text box, enter the IP address of the remote server.
2. In the port text box, enter the port number of the remote server.

3. When completed, click Save to enable the setting.

You can configure the Network Camera to send the system log file to a remote server as a log backup.
Before utilizing this feature, it is suggested that the user install a log-recording tool to receive system log
messages from the Network Camera. An example is Kiwi Syslog Daemon. Visit http://www.kiwisyslog.
com/kiwi-syslog-daemon-overview/.

Kivi Syslog Service Manager (30 Day trial - Version 9.2) =)
Fle Edit View Manage Help B

4 @ A B [Diplay 00 Defeut <] 30 Days leftin evaluation (110

Date Time Priority Hostname  Message

06:27-2011 17:06:57 Userlnfo 192168.4.103 [RTSP SERVER]: Stop one session, IP<192.168.4.101
06:27-2011 17:06:57 Userlnfo 192168.4.103  last message repeated 2 time
06:27-2011 17:06:13 Userlnfo 192168.4.103 [RTSP SERVER]: Stast IP-192.168.4.101

0627-2011 17:06:12 192168.4.103 [RTSP SERVER]: sic#: . XMLSParser_ReadAll File /var/iun/sessioninfo failed! "M
06-27-2011 17:06:12 192.168.4.103 [RTSP SERVER]: XML ent element at line 6°M

06:27-2011 17:06:12 192168.4.103 [RTSP SERVER]: Stop
06:27-2011 17:06:12 192168.4.103 [RTSP SERVERL
06:27-2011 17:06:10 192168.4.103 [UPNP DEVICEL
06:27-2011 17:06:08 192.168.4.103 [DRM Servicel: Starting DRM service.
06272011 17:06:07 I Ready to watch hitpd.
06-27-2011 17:06:06 s 192.168.0.10 192.168.0.20
06-27-2011 17:06:06 e 192168.4.103 uc ter 192.168.4.1
e 192168.4.103 udhcpe: IP 192.168.4.103
192168.4.103 [EVENT MGRI: the process
e 192168.4.103 udhcpe: router 192.16¢
e 192168.4.103 udhcpo: IP 192.168.4.103 netmask 255.255.255.0
e 192.168.4.103 udhepe: deconfig

1921684103 [
e 192168.4.103 ug

06:27-2011 17:06:05
06:27-2011 17:06:03
06272011 17:06:01
06-27-2011 17:06:00 Daer
06-27-2011 17:06:00 Daer

ask 255.255.255.0

ent #1 is skipped because of low priority 0

System log

J System log ‘ ‘ Access log

Jan 5 11:36:07 syslogd 1.5.0: restart. | =
Jan 5 11:36:08 [swatchdog]: Ready to watch httpd.

Jan 5 11:36:09 [EVENT MGR]: Starting eventmgr with support for EcTun

Jan 5 11:36:11 [DRM Service]: Starting DRM service.

Jan 5 11:36:20 [UPnPIGDCP]: Search IGD failed

Jan 5 11:36:23 automount[718]: >> mount: mounting /dev/mmcblkOp1 on /mnt/auto/CF failed: No such

device or address

Jan 5 11:36:23 automount[7 18]: mount(generic): failed to mount /dev/mmcblkOp1 (type viat)

on /mnt/auto/CF

Jan 5 11:36:23 [IR Cut Control]: Day mode

Jan 5 11:36:23 automount[728]: >> mount: mounting /dev/mmcblkOp1 on /mnt/auto/CF failed: No such
device or address L
Jan 5 11:36:23 automount[728]: meunt(generic): failed to mount /dev/mmcblkOp1 (type viat)

on /mnt/aute/CF

Jan 5 11:36:23 [IR Cut Control]: Day mode

Jan 5 11:36:23 [SYS]: Serial number = 0002D10ED4C9

Jan 5 11:36:23 [SYS]: System starts at Wed Jan 5 11:36:23 UTC 2011

This column displays the system log in a chronological order. The system log is stored in the Network
Camera’s buffer area and will be overwritten when reaching a certain limit.
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You can install the included VAST recording software, which provides an Event
Management function group for delivering event messages via emails, GSM short

messages, onscreen event panel, or to trigger an alarm, etc. For more information, refer to
the VAST User Manual.

AV e o

VIVOTEK Network Cameras

I

i’ﬁ“ A
3G Cell phone
/' VIVOCloud
N A
o— @ —2
Cell phone GSM Server with \ Email
Short message Modem

VAST Recording Software

RN
» B8

Deterrent

Digital output PTZ
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Access log

systemlog | g

Jan 5 11:36:28 [RTSP SERVER]: Start one session, IP=172.16.2.52
Jan 5 11:49:15 [RTSP SERVER]: Start one session, IP=192.168.4.105
Jan 5 13:11:20 [RTSP SERVER]: Start one session, IP=192.168.4.105

Access log displays the access time and IP address of all viewers (including operators and

administrators) in a chronological order. The access log is stored in the Network Camera’s buffer
area and will be overwritten when reaching a certain limit.

VADP log

The VADP log displays information for the pre-loaded VADP module, such as the TrendMicro loT security

package. The information includes, package size, activation time, memory size taken, records of automated
updates, etc.
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System > Parameters

The View Parameters page lists the entire system’s parameters. If you need technical
assistance, please provide the information listed on this page.

— Parameters

system hostname='CC9381-HV'

system ledoff='0"

system lowlight='1"
system_date:'2020/08/13'

system time='00:32:25"

system datetime=""

system ntp='192.168.1.14"

system timezoneindex='320"

system daylight enable='0"

system daylight dstactualmode='1l"

system daylight auto begintime='NONE'
system daylight auto endtime='NONE'
system daylight timezones=',-360,-320,-280,-240,-241,-200,-201,-160
system updateinterval='86400"

system info modelname='CC9381-HV'

system info extendedmodelname='CC9381-HV'
system info serialnumber='00C393801004"'
system info firmwareversion='CC9381-VVTK-0100d"'
system info language count='10"

system info language i0='English'

system info language il='Deutsch'

system info language i2='Espafiol'

system info language i3='Francais'

system info language i4='Italiano'
system info language i5=' HAZE

system info language 16='Portugués'
system_info_language_i7:‘ﬁﬁﬁﬂ#j{'
system info language i8=' Ay

system info language 1i9='Pycckuii'

system info language il0=""

B e N B T e W P N i Ry iy [ |

L >

D>
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System > Maintenance

This chapter explains how to restore the Network Camera to factory default, upgrade firmware
version, etc.

General settings > Upgrade firmware

Upgrade firmware

Select firmware file: Browse... [ Upgrade ]

This feature allows you to upgrade the firmware of your Network Camera. It takes a few minutes to
complete the process.
Note: Do not power off the Network Camera during the upgrade!

Follow the steps below to upgrade the firmware:

1. Download the latest firmware file from the VIVOTEK website. The file is in .pkg file format.

2. Click Browse... and locate the firmware file.

3. Click Upgrade. The Network Camera starts to upgrade and will reboot automatically when the upgrade
completes.

If the upgrade is successful, you will see “Reboot system now!! This connection will close”. After that, re-
access the Network Camera.

The following message is displayed when the upgrade has succeeded.

Reboot system now!!
This connection will close.

The following message is displayed when you have selected an incorrect firmware file.
( A
Starting firmware upgrade...
Do not power down the server during the upgrade.
The server will restart automatically after the upgrade is
completed.
This will take about 1 - 5 minutes.
Wrong PKG file format
Unpack fail
& J

General settings > Reboot

Reboot
{

This feature allows you to reboot the Network Camera, which takes about one minute to complete. When
completed, the live video page will be displayed in your browser. The following message will be displayed
during the reboot process.

The device is rebooting now. Your browser will reconnect to http:/1192 168.5.151:80/

Ifthe connection fails, please manually enter the above IP address in your browser.

If the connection fails after rebooting, manually enter the IP address of the Network Camera in the
address field to resume the connection.
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General settings > Restore
— Restore

Restore all seflings to factory default except setiings in

[ ] Metwork [ ] Daylightsaving time [ ] Custom language [ | VADP

| Restore ‘

This feature allows you to restore the Network Camera to factory default settings.

Network: Select this option to retain the Network Type settings (please refer to Network Type on page
77).

Daylight Saving Time: Select this option to retain the Daylight Saving Time settings (please refer to
Import/Export files below on this page).

Custom Language: Select this option to retain the Custom Language settings.
VADP: Retain the VADP modules (3rd-party software stored on the SD card) and related settings.

Focus position: (Remote focus models only) Retain the lens focus position using the previously saved
position parameters.

If none of the options is selected, all settings will be restored to factory default. The following message is
displayed during the restoring process.

The device is rebooting now. Your browser will reconnect to http:/1192.168.5.151:80/
Ifthe connection fails, please manually enter the above IP address in your browser.

This feature allows you to Export / Update daylight saving time rules, custom language file, configuration
file, and server status report.

General settings | | Import/Export files |

Import/Export files

— Export files
Export daylight saving time configuration file
Exportlanguage file
Export configuration file
Export server status report

— Upload files
Update daylight saving time rules: Browse.. | Upload
Update custom language file: Browse.. | Upload
Upload configuration file: Browse_. | Upload

Export daylight saving time configuration file: Click to set the start and end time of DST (Daylight Saving).

Follow the steps below to export:

1. In the Export files column, click Export to export the daylight saving time configuration file from the
Network Camera.

2. A file download dialog will pop up as shown below. Click Open to review the XML file or click Save to
store the file for editing.
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le Download X

Do you want to open or save this file?

Mame: config_dst.xml
Type: ¥ML Document, 11.1 KB
From: 192.168.5.151

[ Open ][ Save ]i Cancel i

harm your computer. [F pou do not trust the zource, do not oper or

@ while files from the Internet can be useful, zome files can potentially
zave this file, What's the risk?

3. Open the file with Microsoft® Notepad and locate your time zone; set the start and end time of DST.
When completed, save the file.

In the example below, DST begins each year at 2:00 a.m. on the second Sunday in March and ends at
2:00 a.m. on the first Sunday in November.

2 config_dst - Notepad

File Edit Format View Help

<Day»</Days A
<weekinMonth=First< weekinMonths
<bayofweek:>sunday</Dayofweek >
<HOUF >2</Hour >

EndTime
</TimeZone:
<Timezone id="-240" name="(GMT-06:00) Central Time (Us and Canada)">
<startTimes
<shift=60</shifts
<Monthz3</Months
<Day></Day>
<weekinMonth>second</week inMonths
<bayofweek>sunday</Dayofweek >
<HOUP >2</Hour s
</startTimes
<EndTime:>
<shift>—60</Shifts>
<Monthz1l</Months>
<Day»</Day>
<weekinMonth>First< weakinMonths
<bayofweek:>sunday</Dayofweek >
<HOUF >2</Hour >

</EndTime:>
</TimazZone>
<Timezone id="-241" name="(GMT-06:00) Mexico City'>

‘ij | ] | =

v

Update daylight saving time rules: Click Browse... and specify the XML file to update.

If the incorrect date and time are assigned, you will see the following warning message when uploading
the file to the Network Camera.

B config_dst - Notepad
File Edit Format View Help

<Day»</Day> A
<weekinMonth>First</weekinMonths=
<bayofweek =sunday</Dayofweek:
<HOour >2</Hour >
</EndTime> =]
</Timezones
<Timezone fd="-240" name="(EMT-06:00) Central Time (Us and Canada)'s
<StartTime:

Invalid <Month> wvalue in TimeZone id: -240 . . .

<shifte60</shifts
<Day></Days
<weekinMonthzsecond</Aweek inMonths
<Dayofweek>sunday</Dayofweek>
<HOUr>2 < Hour >
</StartTimes
<EndTimes>
<shifrr-60</shifts
<Months11l< Months
<Day»</Day>
<weekinMonth>First</weekinMonths=
<bayofweek >sunday</Dayofweek:
<HOUr »2</Hour >

</EndTime>
</Timezones
<Timezone fd="-241" name="(GMT-06:00) mMexico City">

& | i I [ ]
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The following message is displayed when attempting to upload an incorrect file format.

Microsoft Internet Exploren

:" } The file must hawve a .xml filename suffix,

Export language file: Click to export language strings. VIVOTEK provides nine languages: English,
Deutsch, Espaiiol, Frangais, Italiano, P # 3%, Portugués, ffifAd1 3¢, and %48 +¢ < .

Update custom language file: Click Browse... and specify your own custom language file to upload.

Export configuration file: Click to export all parameters for the device and user-defined scripts.

Update configuration file: Click Browse... to update a configuration file. Please note that the model and
firmware version of the device should be the same as the configuration file. If you have set up a fixed IP
or other special settings for your device, it is not suggested to update a configuration file.

Export server staus report: Click to export the current server status report, such as time, logs,
parameters, process status, memory status, file system status, network status, kernel message ... and so
on.

-‘@'— Tips:

+ If a firmware upgrade is accidentally disrupted, say, by a power outage, you still have a last resort
method to restore normal operation. See the following for how to bring the camera back to work:

Applicable scenario:

(a) Power disconnected during firmware upgrade.
(b) Unknown reason causing abnormal LED status, and a Restore cannot recover normal working
condition.

You can use the following methods to activate the camera with its backup firmware:

(a) Press and hold down the reset button for at least one minute.

(b) Power on the camera until the Red LED blinks rapidly.

(c) After boot up, the firmware should return to the previous version before the camera hanged. (The
procedure should take 5 to 10 minutes, longer than the normal boot-up process). When tthis
process is completed, the LED status should return to normal.
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Media > Image

This section explains how to configure the image settings of the Network Camera. The
Focus window is available only for models that come with motorized lens.

General settings | | IR control | | Image settings | | Exposure | | Privacy mask

General settings

Video settings

Video title

[[] Show timestamp and video fitle in video and snapshots

Position of timestamp and video fitle on image: Top ﬂ
Timestamp and video title font-size: 30[v]
Video font (.itf): Default [v]
Color: () BMW (@ Color
Power line frequency: ()50 Hz (@60 Hz
Video orientation: Flip Mirrar
[] Rotate

Video title

Show_timestamp_and video_title_in_video_and_snapshots: Enter a name that will be displayed on
the title bar of the live video as the picture shown below. A zoom indicator will be displayed on the
Home page when you zoom in/out on the live viewing window as shown below. You may zoom in/
out on the image by scrolling the mouse wheel inside the live viewing window, and the maximum
zoom in will be up to 4 times.

Video Title /) 2014/7/09 17:08:56
Title and Time

st w—ﬂ J
0l (2l n][e][e][w][w]

Position of timestamp and video title on image: Select to display time stamp and video title on the
top or at the bottom of the video stream.

Timestamp and video title font size: Select the font size for the time stamp and title.

Video font (.ttf): You can select a True Type font file for the display of textual messages on video.

Color: Select to display color or black/white video streams.

Power line frequency: Set the power line frequency consistent with local utility settings to eliminate
image flickering associated with fluorescent lights. Note that after the power line frequency is
changed, you must disconnect and reconnect the power cord of the Network Camera in order for
the new setting to take effect.

Video orientation: Flip - vertically reflect the display of the live video; Mirror - horizontally reflect the
display of the live video. Select both options if the Network Camera is installed upside-down (e.g.,
on the ceiling) to correct the image orientation. Please note that if you have preset locations, those
locations will be cleared after flip/mirror setting.
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Rotate -

Mirror Rotate 90°
mp clockwise

E

([V]iRotate  gp E| Degrees

The rotation here indicates clockwise
rotation. Rotation can be applied with

flip, mirror, and physical lens rotation /\EL L]

(see below) settings to adapt to different

mounting locations. [] \/{

The figures in the illustration are shown in
a consecutive order.

N -

7

The camera may be installed on a vertical, side-facing, or tilted surface in order to accommodate
the interior or exterior design of a building. The interior of a building can be shaped as a narrow
rectangular space, such as corridor. The conventional HD image, such as that of a 16:9 aspect
ratio, will be incongruous with its wide horizontal view. With video rotation, the camera can more
readily cover the field of view on a tall and narrow scene.

Day/Night Settings — DaylNight settings

Switch to BAV in night mode

IR cut filier- ' Schedule mode ~

Day mode: From |D?:0D |t0 | 18:00 |[hh:mm]

Switch to B/W in night mode
Select this to enable the Network Camera to automatically switch to Black/White during night
mode.

IR cut filter

With a removable IR-cut filter, this Network Camera can automatically remove the filter to let IR
light enter the light sensor during low light conditions.

m Auto mode
The Network Camera automatically removes the filter by judging the level of ambient light.

m Day mode
In day mode, the Network Camera switches on the IR cut filter at all times to block infrared light
from reaching the sensor so that the colors will not be distorted.

m Night mode
In night mode, the Network Camera switches off the IR cut filter at all times for the sensor to
accept infrared light, thus helping to improve low light sensitivity.
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m Schedule mode
The Network Camera switches between day mode and night mode based on a specified
schedule. Enter the start and end time for day mode. Note that the time format is [hh:mm] and is
expressed in 24-hour clock time. By default, the start and end time of day mode are set to 07:00
and 18:00.

Sensitivity of IR cut filter
Tune the responsiveness of the IR filter to lighting conditions as Low, Normal, or High.

When completed with the settings on this page, click Save to enable the settings.
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-‘@'— Tips:

If there is an object in close proximity, the IR lights
reflected back from it can mislead the Smart IR’s
calculation of light level. To solve this issue, you
can place an “Exposure Exclude” window on an
unavoidable object in the Exposure setting window.
See page 63 for how to do it.

You can also configure the “Exposure Exclude”
window in a night mode “Profile” setting so that your
day time setting is not affected.

=Profile of exposure settings

[ Activated period
Enable and apply this profile to
) Day mode

@ Night mode

© Schedule mode

~ Measurement window

© Full view

@) Custom

@ BLC
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Image settings

On this page, you can tune the White balance and Image adjustment.

|(i!mmlselfl|]s ‘ ‘ Image settings || Expm;!ln| Focus | Privacy mask ‘

Sensor Setting 2:

For special situations et s moce] [Promomass] |
e

Auto Fixcurrentvalue:|_on | [TOR T

— Image adij

>

Sensor Setting 1:
For normal situations

Brightness. 50%

Contrast: 50%

Saturation: 50%

(ol ol O

Sharpness:
‘Gamma cune; Opﬁmnze.

—— Nofnn

50%

Resfore H Save

White balance: Adjust the value for the best color temperature.
m You may follow the steps below to adjust the white balance to the best color temperature.

1. Place a sheet of paper of white or cooler-color temperature color, such as blue, in front of the
lens, then allow the Network Camera to automatically adjust the color temperature.

2. Click the On button to Fix current value and confirm the setting while the white balance is being
measured.

m You may also manually tune the color temperature by pulling the RGain and BGain slide bars.

Image Adjustment
m Brightness: Adjust the image brightness level, which ranges from 0% to 100%.

m Contrast: Adjust the image contrast level, which ranges from 0% to 100%.
m Saturation: Adjust the image saturation level, which ranges from 0% to 100%.
m Sharpness: Adjust the image sharpness level, which ranges from 0% to 100%.

m Gamma curve: (Note that Gamma curve is disabled when the WDR function is enabled)
Adjust the image sharpness level, which ranges from 0 to 0.45.
You may let firmware Optimize your display or select a value to change the preferred level of
Gamma correction towards higher contrast or towards the higher luminance for detailed expression
for both dark and lighted areas of an image.

Defog: Defog helps improve the visibility quality of captured image in poor weather conditions such
as smog, fog, or smoke.
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Noise reduction

m Enable noise reduction: Check to enable noise reduction in order to reduce noises and flickers
in image. This applies to the onboard 3D Noise Reduction feature. Use the pull-down menu to
adjust the reduction strength. Note that applying this function to the video channel will consume
system computing power.

3D Noise Reduction is mostly applied in low-light conditions. When enabled in a low-light
condition with fast moving objects, trails of after-images may occur. You may then select a lower
strength level or disable the function.

Note that the Preview button has been cancelled, all changes made to image settings is directly
shown on screen. You can click Restore to recall the original settings without incorporating the
changes. When completed with the settings on this page, click Save to enable the setting. You
can also click on Profile mode to adjust all settings above in a tabbed window for special lighting
conditions.

Normal light mode ‘ | Profile mode |

Enable to apply these settings at ~

® Mightmode () Schedule mode I

Enable to apply these settings at: Select the mode this profile to apply to: Day mode, Night mode, or
Schedule mode. Please manually enter a range of time if you choose Schedule mode. Then check
Save to take effect.
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Exposure

On this page, you can configure the Exposure measurement window, Exposure level, Exposure
mode, Exposure time, Gain control, and Day/Night mode settings. You can configure two sets of
Exposure settings: one for normal situations, the other for special situations, such as the day/night/

schedule mode.

Sensor Setting 2:
For special situations

Sensor Setting 1:

| General settings | ‘ IR control | | Image settings | | Exposure | | Privacy mask |

| Normal light mod | | | I
L —

| Select auto mode will disable profile of exposure settings.

— M % wrind,

@ Fullview (Custom () BLC

— Exposure control

For normal situations

Exposure level: 0

[] Flickerless

Exposure time:

:)— 1132000 - 1/30

o

Gain control:

u 0-100%

Lo

Restore | Save |

Measurement Window: This function allows users to set measurement window(s) for low light

compensation. For example, where low-light objects are posed against an extremely bright
background. You may want to exclude the bright sunlight shining through a building's corridor.

m Full view: Calculate the full range of view and offer appropriate light compensation.

m Custom: This option allows you to manually add customized windows as inclusive or exclusive
regions. A total of 10 windows can be configured. Please refer to the next page for detailed

illustration.
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The inclusive window refers to the “weighed window®; the exclusive window refers to “ignored
window". It adopts the weighed averages methodology to calculate the value. The inclusive
windows have a higher priority. You can overlap these windows, and, if you place an exclusive
window within a larger inclusive window, the exclusive part of the overlapped windows will
be deducted from the inclusive window. An exposure value will then be calculated out of the
remaining of the inclusive window.

Weighted region

Ignored region

Add inclusive window ] [ Add exclusive window

Measurement window

) Fullview @ Custom (0 BLC

m BLC (Back Light Compensation): This option will automatically add a “weighted region® in the
middle of the window and give the necessary light compensation.

m HLC: (Highlight Compensation). Firmware detects strong light sources and compensates on
affected spots to enhance the overall image quality. For example, the HLC helps reduce the
glares produced by spotlights or headlights.

Exposure control:

m Exposure level: You can manually set the Exposure level, which ranges from -2.0 to +2.0 (dark
to bright). You can click and drag the semi-circular pointers on the Exposure time and Gain
control slide bars to specify a range of shutter time and Gain control values within which the
camera can automatically tune to an optimal imaging result. You may prefer a shorter shutter
time to better capture moving objects, while a faster shutter reduces light and needs to be
compensated by the electrical brightness gains.

m Exposure mode:

When the Manual mode is selected, you can click and drag the semi-circular pointers on the
Exposure time and Gain control slide bars to specify a range of shutter time and Gain control
values within which the camera can automaticallly tune to an optimal imaging result. You can
also configure the iris size to control the amount of light. For example, you may prefer a shorter
shutter time to better capture moving objects, while a faster shutter reduces light and needs to be
compensated by electrical brightness gains.



- Flickerless:
Fixed iris models can encounter image rolling band issues when operating under incongrous

power line frequency with fluorescent lights. To solve the problem, the Flickerless mode can limit
the exposure time to 1/120 ~ 1/5 second. For the Auto iris models, when the exposure time is
limited to 1/120 ~1/5 second, iris size is automatically adjusted, and that the image brightness
is appropriately adjusted. Although the chance is rare, for Fixed iris models, when the exposure
time is limited to 1/120 ~ 1/5 second, they may encounter image over-exposure. If the Flickerless
option is selected, and users discover over-exposure from the live view, they can disable the
Flickerless option.

Auto: If you set Exposure mode as Auto, the Exposure time and Gain control will not be
configurable since the sensor library will automatically adjust the value according to the ambient
light. Then you can configure iris mode as “indoor” or “outdoor” to reach the best image quality.

You can click Restore to recall the original settings without incorporating the changes. When
completed with the settings on this page, click Save to enable the settings.

If you want to configure another sensor setting for day/night/schedule mode, please click Profile to
open the Profile of exposure settings page as shown below.

Activated period: Select the mode this profile to apply to: Day mode, Night mode, or Schedule
mode. Please manually enter a range of time if you choose Schedule mode. Then click Save for the
configuration to take effect.

General settings | | IR control | | Image settings | | Exposure | | Privacy mask

e 7))

The Profile mode is not available when the IR cut
filter is configured in the Auto mode.

Please follow the steps below to set up a profile:

1. Select the Profile mode tab.

2. Select the applicable mode: Night mode or
Schedule mode. Please manually enter a
range of time if you choose Schedule mode.

3. Configure Exposure control settings in the
folowing columns. Please refer to previous
dicussions for detailed information.

4. Click Save to enable the setting and click
Close to exit the page.

Normal light mode | | Profile mode

Measurement window A

@ Fullview () Custom () BLC

Exposure control

Exposure level: 0 [¥]
[] Flickerless
Exposure time: | — 1/32000 - 1/30
Gain control- q 0-100 %
/) NOTE: ‘
- AE speed adjustment
v
Note that when the WDR Pro function is enabled, I1 Enatie AZ speed adlustment
the Measurement window is not configurable. Restore || saw

m AE Speed Adjustment:

This function (Automatic Exposure) applies when you need to monitor fast changing lighting
conditions. For example, the camera may need to monitor a highway lane or entrance of a
parking area at night where cars passing by with their lights on can bring fast changes in light
levels. The same applies if the camera is installed on a vehicle, and when it needs to adapt to
fast changes of light when entering and leaving a tunnel. The speed level and sensitivity can be
manually adjusted.
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= WDR Pro:

This refers to the Wide Dynamic Range function that enables the camera to capture details in
a high contrast environment. Use the checkbox to enable the function, and use the slide bar
to select the strength of the WDR Pro functionality, depending on the lighting condition at the
installation site. You can select a higher effect when the contrast is high (between the shaded
area and the light behind the objects).

Enable WDR enhanced: This function allows users to identify more image details with an extreme
contrast from an object of interest with one shadowed side against a bright background, e.g., an
entrance. You may select the Enable WDR enhanced checkbox, and then adjust the strength (low,
medium, high) to reach the best image quality.
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Privacy mask

Click Privacy Mask to open the settings page. On this page, you can block out sensitive zones to
address privacy concerns.

%mmnmmnpmmq

Enable privacy mask

Window name

areaB

| New @Sm |

m To set the privacy mask windows, follow the steps below:

1. Click New to add a new window.

2. You can use 4 mouse clicks to create a new masking window, which is recommended to be at
least twice the size of the object (height and width) you want to cover.

3. Enter a Window Name and click Save to enable the setting.

4. Click on the Enable privacy mask checkbox to enable this function.

J NOTE:
» Up to 5 privacy mask windows can be set up on the same screen.

» If you want to delete the privacy mask window, please click the x’ mark on the side of window
name.
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Media > Video

Mode
[ [ steam |

¥ Video sefings for stream 1 Viewing Window

# Video sefiings for stream 2 Viewing Window

# Video settings for stream 3

The applicable video modes include:

m 5MP (WDR): This mode features the 5MP resolution with a frame rate of 20fps.

m 1080P Full HD (16:9) (WDR): If the need should arise for a high-contrast lighting environment,
you can select this mode with the aid of the WDR Pro feature.

m Stream 3: The default frame size for Stream 3 is set to the 2048 x 1536.

Click Viewing Window to open the viewing region settings page. On this page, you can configure
the Region of Interest and the Output Frame Size for a video stream. For example, you can crop
only a portion of the image that is of your interest, and thus save the bandwidth needed to transmit
the video stream. As the picture shown below, the area of your interest in a parking lot should be
the vehicles. The blue sky is of little value for the surveillance purpose.
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Stream settings
’m‘ Stream

¥ Video seftings for stream 1 Viewing Window

¥ Video sefings for stream 2 Viewing Window

 Video settings for stream 3

This Network Camera supports multiple streams with frame sizes ranging from 176 x 144 to 2048 x
1536 pixels.

The definition of multiple streams:

m Stream 1: Users can define the "Region of Interest" (viewing region) and the "Output Frame Size"
(size of the live view window).

m Stream 2: The default frame size for Stream 2 is set to the 640 x 480.

m Stream 3: The default frame size for Stream 3 is set to the 2048 x 1536.

Click Viewing Window to open the viewing region settings page. On this page, you can configure
the Region of Interest and the Output Frame Size for a video stream. For example, you can crop
only a portion of the image that is of your interest, and thus save the bandwidth needed to transmit
the video stream. As the picture shown below, the area of your interest in a parking lot should be
the vehicles. The blue sky is of little value for the surveillance purpose.
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[ [Vowing oo

Video stream: Stream 2 -

Full view: 1920x1080

Region of interest : (0,0} 800x600 custorr - Save Close

Mote: Frame size will be changed to match region of interest.

Please follow the steps below to set up the configurations of a video stream:

1. Select a stream for which you want to set up the viewing region.

2. Select a Region of Interest from the drop-down list. The floating frame, the same as the one
in the Global View window on the home page, will resize accordingly. If you want to set up
a customized viewing region, you can also resize and drag the floating frame to a desired
position with your mouse.

. Choose a proper Output Frame Size from the drop-down list according to the size of your
monitoring device.

w

{J NOTE:
All the items in the "Region of interest" should not be larger than the "Output Frame Size"
(current maximum resolution).

m The parameters of the multiple streams:

2048 x 1536 ~ 176 x 144 (Selectable) 2048 x 1536 ~ 176 x 144 (Selectable)

_ 2048 x 1536 ~ 176 x 144 (Selectable) 2048 x 1536 ~ 176 x 144 (Selectable)

2048 x 1536 ~ 176 x 144 (Selectable) 2048 x 1536 ~ 176 x 144 (Selectable)
Fixed Fixed

When completed with the settings in the Viewing Window, click Save to enable the settings and
click Close to exit the window. The selected Output Frame Size will immediately be applied to
the Frame size of each video stream. Then you can go back to the home page to test the e-PTZ
function. For more information about the e-PTZ function, please refer to page 108.

* viverEk CC8371-HV

Region of Interest
(Viewing Region)

@llu(s)(e) iG] crorsm

Output Frame Size
(Size of the Live View Window)
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Click the stream item to display the detailed information. The maximum frame size will follow your
settings in the above Viewing Window sections.

= Video settings for stream 1 Viewing Window

@H264
Frame size: 2048x1536 v
Maximum frame rate:
Intra frame period:

Smart stream I
[+ Dynamic intra frame period (Help)
[¥] Smart codec:
Mode:
Quality priority” (Help) s :L)': 2
Bit rate control
(@ Constrained bit rate:
Foicy

() Fixed quality:

Target quality:

Maximum bit rate:

(OJPEG
“ Video settings for stream 2 Viewing Window
@H264
Frame size:
Maximum frame rate: 15108 ™
Intra frame period:
‘Smart stream Il
[ Dynamic intra frame period (Help)
[¥] Smart codec:
Moge:
Quality priority” (Help) s =‘L)'= a2
Bit rate control
(® Constrained bit rate:
Naximum bit rate:
baier

) Fixed quality:

Target quality:

OJPEG

This Network Camera provides a real-time H.264 compression standard for real-time
viewing. If the H.264 mode is selected, the video is streamed via RTSP protocol. There are
several parameters through which you can adjust the video performance:

@ H.264
&Ei7E 2048x1536 v
Maximum Trame rate:
Intra frame period:

Smart stream |l
[¥] Dynamic intra frame peried (Help)
[+#] Smart codec:

Mode:
Quality priority: (Help) b~ a

Bit rate control

(@ Constrained bit rate:

Target quality:
Maximum bit rate:
Policy:

() Fixed quality:

m Frame size

AMbps  wv
Frame rate priority  »

You can set up different video resolutions for different viewing devices. For example,
configure a smaller frame size and lower bit rate for remote viewing on mobile phones
and a larger video size and a higher bit rate for live viewing on web browsers, or
recording the stream to an NVR. Note that a larger frame size takes up more bandwidth.

m Maximum frame rate -

This limits the maximum refresh frame rate per second. Set the frame rate higher for

smoother video quality and for recognizing moving objects in the field of view.
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If the power line frequency is set to 50Hz, the frame rates are selectable at 1fps, 2fps,
3fps, 5fps, 8fps, 10fps, 15fps, 20fps, and 25fps. If the power line frequency is set to
60Hz, the frame rates are selectable at 1fps, 2fps, 3fps, 5fps, 8fps, 10fps, 15fps, 20fps,
25fps, and 30fps. You can also select Customize and manually enter a value.

The frame rate will decrease if you select a higher resolution.

m Intra frame period
Determine how often for firmware to plant an | frame. The shorter the duration, the
more likely you will get better video quality, but at the cost of higher network bandwidth
consumption. Select the intra frame period from the following durations: 1/4 second, 1/2
second, 1 second, 2 seconds, 3 seconds, and 4 seconds.

m Bit rate control

Constrained bit rate:

A complex scene generally produces a larger file size, meaning that higher bandwidth
will be needed for data transmission. The bandwidth utilization is configurable to
match a selected level, resulting in mutable video quality performance. The bit rates
are selectable at the following rates: 20Kbps, 30Kbps, 40Kbps, 50Kbps, 64Kbps,
128Kbps, 256Kbps, 512Kbps, 768Kbps, 1Mbps, 2Mbps, 3Mbps, 4Mbps, 6Mbps,
8Mbps, 10Mbps, 12Mbps, 14Mbps, ~ to 40Mbps. You can also select Customize
and manually enter a value up to 40Mbps.

« - Target quality: Select a desired quality ranging from Medium to Excellent
- Maximum bit rate: select a bit rate from the pull-down menu. The bit rate ranges
from 20kbps to a maximum of 40Mbps. The bit rate then becomes the Average or
Upper bound bit rate number. The Network Camera will strive to deliver video streams
around or within the bit rate limitation you impose.

- Policy: If Frame Rate Priority is selected, the Network Camera will try to maintain
the frame rate per second performance, while the image quality will be compromised.
If Image quality priority is selected, the Network Camera may drop some video
frames in order to maintain image quality.
Fixed quality:

On the other hand, if Fixed quality is selected, all frames are transmitted with the
same quality; bandwidth utilization is therefore unpredictable. The video quality
can be adjusted to the following settings: Medium, Standard, Good, Detailed, and
Excellent. You can also select Customize and manually enter a value.

Maximum bit rate: With the guaranteed image quality, you might still want to place
a bit rate limitation to control the size of video streams for bandwidth and storage
concerns. The configurable bit rate starts from 1Mbps to 40Mbps.

The Maximum bit rate setting in the Fixed quality configuration can ensure a
reasonable and limited use of network bandwidth. For example, in low light conditions
where a Fixed quality setting is applied, video packet sizes can tremendously
increase when noises are produced with electrical gains.

You may also manually enter a bit rate number by selecting the Customized option.



+ Smart stream lll: Smart stream effectively reduces the quality of the whole or the
non-interested areas on a screen and therefore reduces the bandwidth consumed.

m Dynamic Intra frame period
High quality motion codecs, such as H.264, utilize the redundancies between video frames to

deliver video streams at a balance of quality and bit rate.
The encoding parameters are summarized and illustrated below. The I-frames are completely

self-referential and they are largest in size. The P-frames are predicted frames. The encoder
refers to the previous I- or P-frames for redundant image information.

H.264 Frame Types

PI1 PPPPPPPI PPPPPPPI
By dynamically prolonging the intervals for I-frames insertion to up to 10 seconds, the bit rates
required for streaming a video can be tremendously reduced. When streaming a video of a
static scene, the Dynamic Intra frame feature can save up to 53% of bandwidth. The amount of
bandwidth thus saved is also determined by the activities in the field of view. If activities occur
in the scene, firmware automatically shortens the I-frame insertion intervals in order to maintain
image quality. In the low light or night conditions, the sizes of P-frames tend to be enlarged due
to the noises, and hence the bandwidth saving effect is also reduced.

Streaming a typical 2MP scene normally requires 3~4Mb/s of bandwidth. With the Dynamic Intra
frame function, the bandwidth for streaming a medium-traffic scene can be reduced to 2~3Mb/s,
and during the no-traffic period of time, down to 500kb/s.

static scenes

@ A Dynamic Intra Frame w/
]

PIPPPPPPPPPPPPPPPPPPPI Static scene

55 > |
N Dynamic Intra Frame w/
ﬁ ,?_ activities in scenes
PI PPPPPPPI PPPPPPPIPPP Activities

< >| < >
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With the H.265 codec in an optimal scenario and when Dynamic Intra frame is combined with
the Smart Stream function, an 80% of bandwidth saving can be achieved compared with using
H.264 without enabling these bandwidth-saving features.

m Smart FPS

In a static scene, the algorithm puts old frames in queue when no motions occur in scene. When
motions occur, the encoding returns to normal to deliver real-time streaming.

H-H-H-HH-

f1 f1 £ f1 5 f5 f5 f5 f9

Occur.
(R SRR RN R
f4 5 f6 7 8 {9

Moti
f1 f1 3

By queuing the old frames from a static scene, both the computing efforts and the size of P
frames are reduced. It is beneficial for keeping up with the frame rate requirements.

A default frame difference threshold, 1%, is embedded in firmware for returning from Smart FPS
to normal encoding when motions occur.

@ NOTE:

Comparing with Smart Stream II, Smart Stream |ll has two more configurable options: Smart Q,
and Smart FPS.
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You can manually specify the video quality for the foreground and the background areas.

+ Smart codec: Smart codec effectively reduces the quality of the whole or the non-
interested areas on a screen and therefore reduces the bandwidth consumed.

(@) Smart stream:

Foreground quality:
Background quality
Maximum bit rate: 40 Mbps W
Made:

Manual window setting

Select an operation mode if Smart stream is preferred.

- Auto tracking: The Auto tracking mode configures the whole screen into the background
area. The video quality of part of the screen returns to normal when one or more
objects move in that particular area. The remainder of the screen where there are
no moving objects (no pixel changes) will still be transmitted in low-quality format.

- Manual: The Manual mode allows you to configure 3 ROl windows (the Foreground
areas) on the screen. Areas not included in any ROI windows will be considered as
the Background areas. The details in the ROI areas will always be transmitted in a
higher-quality video format.

As illustrated below, the upper screen may contain little details of your interest,
while the sidewalk on the lower screen is included in an ROl window.

Restore | | Close | | Save




As the result, the lower screen is constantly displayed in high details,
while the upper half is transmitted using a lower-quality format. Although
the upper half is transmitted using a lower quality format, you still have an
awareness of what is happening on the whole screen.

—

Fore

ground: higher-quality
T e |

- Hybrid: The major difference between the “Manual” mode and the “Hybrid”
mode is that:

In the “Hybrid“ mode, any objects entering the background area
will restore the video quality of the moving objects and the area
around them. The video quality of the associated background area is
immediately restored to normal to cover the moving objects.

In the “Manual” mode, the background area is always transmitted using
a low-quality format regardless of the activities inside.

You should also select the Maximum bit rate from the pull-down menu as the
threshold to contain the bandwidth consumption for both the high- and low-
quality video sections in a smart stream.



m Bit rate control
Constrained bit rate:

A complex scene generally produces a larger file size, meaning that higher bandwidth
will be needed for data transmission. The bandwidth utilization is configurable to
match a selected level, resulting in mutable video quality performance. The bit rates
are selectable at the following rates: 20Kbps, 30Kbps, 40Kbps, 50Kbps, 64Kbps,
128Kbps, 256Kbps, 512Kbps, 768Kbps, 1Mbps, 2Mbps, 3Mbps, 4Mbps, 6Mbps,
8Mbps, 10Mbps, 12Mbps, 14Mbps, ~ to 40Mbps. You can also select Customize
and manually enter a value up to 40Mbps.

« - Target quality: Select a desired quality ranging from Medium to Excellent.

- Maximum bit rate: select a bit rate from the pull-down menu. The bit rate ranges
from 20kbps to a maximum of 40Mbps. The bit rate then becomes the Average or
Upper bound bit rate number. The Network Camera will strive to deliver video streams
around or within the bit rate limitation you impose.

- Policy: If Frame Rate Priority is selected, the Network Camera will try to maintain
the frame rate per second performance, while the image quality will be compromised.
If Image quality priority is selected, the Network Camera may drop some video
frames in order to maintain image quality.

Smart Q: Select ON or OFF to enable or disable the feature. Smart Q is scene-aware.
The Smart Q reduces frame size and bit rate consumption through the following:

m Dynamically adjusting the image quality for scenes in different luminosities in low
light frames. Less noises means less of the bandwidth consumed.

m Endorsing different qualities for the | frames and P frames, and hence reduces
the frame size.

m Dividing a single frame into different sections, and giving these sections different
qualities. For a highly complex area, such as an area with dense vegetation,

screen windows, or repeated patterns (complex textiles patterns like wall paper),
having a lower quality value actually poses little effects on human eyes.

Unnecessary quality is unrecognized by human eyes and wastes the bit rate.

The Smart Q streaming can save up to 50% to 80% of bandwidth in different
illumination conditions while keeping the same imaging quality. These numbers come
from the comparison between Smart Stream Il and Smart Stream lll streamings.
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Fixed quality:
On the other hand, if Fixed quality is selected, all frames are transmitted with the
same quality; bandwidth utilization is therefore unpredictable. The video quality
can be adjusted to the following settings: Medium, Standard, Good, Detailed, and
Excellent. You can also select Customize and manually enter a value.

Maximum bit rate: With the guaranteed image quality, you might still want to place
a bit rate limitation to control the size of video streams for bandwidth and storage
concerns. The configurable bit rate starts from 1Mbps to 40Mbps.

The Maximum bit rate setting in the Fixed quality configuration can ensure a
reasonable and limited use of network bandwidth. For example, in low light conditions
where a Fixed quality setting is applied, video packet sizes can tremendously
increase when noises are produced with electrical gains.

You may also manually enter a bit rate number by selecting the Customized option.
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If JPEG mode is selected, the Network Camera sends consecutive JPEG images to the
client, producing a moving effect similar to a filmstrip. Every single JPEG image transmitted
guarantees the same image quality, which in turn comes at the expense of variable
bandwidth usage. Because the media contents are a combination of JPEG images, no
audio data is transmitted to the client. There are three parameters provided in MJPEG
mode to control the video performance:

@ JPEG
Frame size:
Maximum frame rate:
Wideo quality
() Constant bit rate:
(@) Fixed quality:
Quality:
Maximum bit rate:

m Frame size

You can set up different video resolutions for different viewing devices. For example, set
a smaller frame size and lower bit rate for remote viewing on mobile phones and a larger
video size and a higher bit rate for live viewing on web browsers. Note that a larger
frame size takes up more bandwidth.

m Maximum frame rate

This limits the maximum refresh frame rate per second. Set the frame rate higher for
smoother video quality.

If the power line frequency is set to 50Hz, the frame rates are selectable at 1fps, 2fps,
3fps, 5fps, 8fps, 10fps, and 15fps, and up to 50fps. If the power line frequency is set to
60Hz, the frame rates are selectable at 1fps, 2fps, 3fps, 5fps, 8fps, 10fps, 12fps, 15fps,
and up to 30fps. You can also select Customize and manually enter a value. The frame
rate will decrease if you select a higher resolution.

m Video quality

Refer to the previous page setting an average or upper bound threshold for controlling
the bandwidth consumed for transmitting motion jpegs. The configuration method is
identical to that for H.264.

For the Constant Bit Rate and other settings, refer to the previous page for details.

{J NOTE:

» Video quality and fixed quality refer to the compression rate. A lower value produces higher
quality. The higher the compression rate, the lower the quality.

» Converting high-quality video significantly increases the CPU load, and you may encounter
streaming disconnection or video loss while capturing a complicated scene. In the event of video
loss, we suggest you customize the video stream to a lower resolution or reduce the frame rate
for a smoother video.
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Media > Audio

Audio Settings

— Audio settings

[ Mute
Internal microphone input gain: "

0 100%
Audio type

® G711 pemu[ ]

() G 726 bit rate: 32 Kbps[v]

Mute: Select this option to disable audio transmission from the Network Camera to all clients. Note
that if muted, no audio data will be transmitted even if audio transmission is enabled on the Client
Settings page. In that case, the following message is displayed:

The media type has been changed to video only because the media From server contains no audio

Microphone source: Select to stream the audio from the internal microphone or the external
microphone.

Microphone input gain: Select the gain of the audio input according to ambient conditions. Adjust
the gain between 100% and 0%.

Audio type: Select audio codec and the sampling bit rate .

m G.711 also provides good sound quality and requires about 64Kbps. Select pcmu (u-Law) or
pcma (A-Law) mode.

m G.726 is a speech codec standard covering voice transmission at rates of 16, 24, 32, and 40kbit/
S.

When completed with the settings on this page, click Save to enable the settings.
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Media profiles

You can configure a different video stream for each of the 3 default profiles, Max. view,
Recording, and Live view.

The related video stream information will display, including stream number, resolution,
codec used, frame rate, etc. The Multicast port number, and address for video, audio, and
Metadata configuration will also be listed.

> Stream profiles setup
Pt name

Always multicast for this stream profile

- Video configuration

Setup a video configuration

— Source
Stream No: Stream 1
Codec: H.264 Resolution: 2048x2048
Frame rate: 15 Bit rate (kbit/s): 6000000

— Multicast
Port: 15560 Address: 239.240.7.99
RTCF Fort: 15561 Multicast TTL [1~255]: 15

- Audio configuration

Setup an audio configuration

— Source
Codec: G711
— Multicast
Port: 15562 Address: 239.240.7.99
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Network > General settings

This section explains how to configure a wired network connection for the Network
Camera.

Network Type Network type || Port

@ LAN

® Get IP address automatically

@ Use fixed IP address

Enable UPnP presentation

Enable UPnP port forwarding
) PPPoE

Enable IPvE

LAN ——

Select this option when the Network Camera is deployed on a local area network (LAN) and is
intended to be accessed by local computers. The default setting for the Network Type is LAN.
Please rememer to click on the Save button when you complete the Network setting.

Get IP address automatically: Select this option to obtain an available dynamic IP address assigned
by the DHCP server each time the camera is connected to the LAN.

Use fixed IP_address: Select this option to manually assign a static IP address to the Network

Camera.
Network type Port
@ LAN

O Get IP address automaticaly

@ Use fixed IP address

passass
-
Default router:
by 1
-
Primary WINS server:
Secondary WINS server:

Enable UPnP presentation
Enable UPnP port forwarding
) PPROE

Enable IPvG

1. You can make use of VIVOTEK Installation Wizard 2 on the software CD to easily set up the
Network Camera on LAN. Please refer to Software Installation on page 18 for details.

2. Enter the Static IP, Subnet mask, Default router, and Primary DNS provided by your ISP or
network administrator.

Subnet mask: This is used to determine if the destination is in the same subnet. The default value
is “255.255.255.0".

Default router: This is the gateway used to forward frames to destinations in a different subnet.
Invalid router setting will disable the transmission to destinations across different subnets.
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Primary DNS: The primary domain name server that translates hostnames into IP addresses.

Secondary DNS: Secondary domain name server that backups the Primary DNS.

Primary WINS server: The primary WINS server that maintains the database of computer names
and IP addresses.

Secondary WINS server: The secondary WINS server that maintains the database of computer
names and IP addresses.

Enable UPnP presentation: Select this option to enable UPnP™ presentation for your Network
Camera so that whenever a Network Camera is presented to the LAN, the shortcuts to connected
Network Cameras will be listed in My Network Places. You can click the shortcut to link to the web
browser. Currently, UPnP™ is supported by Windows XP or later. Note that to utilize this feature,
please make sure the UPnP™ component is installed on your computer.

% My Network Places
File  Edit Wiew Favorites Tools  Help #

e Back e @ p Search % Folders v

Address q My Metwork Places Iv'| o
Local Network

Network Tasks @

L Add a network place [ | wireless Metwork Camera
(192,168.5.128)
s, il

G Wiew network connections
Set up a home o small ) )
office network | wrireless Metwork Camera with
¥y Wiew workgroup computers PanTilk {192.168.5.141)
sl

Enable UPnP port forwarding: To access the Network Camera from the Internet, select this option
to allow the Network Camera to open ports automatically on the router so that video streams can
be sent out from a LAN. To utilize of this feature, make sure that your router supports UPnP™ and
it is activated.

D Mega-pixel Network Camera (192.168.5.151)

PPPoE (Point-to-point over Ethernet)

Select this option to configure your Network Camera to make it accessible from anywhere as long
as there is an Internet connection. Note that to utilize this feature, an account provided by your ISP
is necessary.

Follow the steps below to acquire your Network Camera’s public IP address.

1. Set up the Network Camera on the LAN.

2. Go to Configuration > Event > Event settings > Add server (please refer to Add server on page
116) to add a new email or FTP server.

3. Go to Configuration > Event > Event settings > Add media (please refer to Add media on page
121).
Select System log so that you will receive the system log in TXT file format which contains the
Network Camera’s public IP address in your email or on the FTP server.

4. Go to Configuration > Network > General settings > Network type. Select PPPoE and enter the
user name and password provided by your ISP. Click Save to enable the setting.

— Network type

O LAN

@ PPPoE
User name:
Password:
Confirm password:

Enable IPvE

_Save
5. The Network Camera will reboot.
6. Disconnect the power to the Network Camera; remove it from the LAN environment.
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@ NOTE:

» If the default ports are already used by other devices connected to the same router, the Network
Camera will select other ports for the Network Camera.

» If UPnP™ is not supported by your router, you will see the following message:
Error: Router does not support UPnP port forwarding.

» Steps to enable the UPnP™ user interface on your computer:

Note that you must log on to the computer as a system administrator to install the UPnP™
components.

1. Go to Start, click Control Panel, then click Add or Remove Programs.

® Control Panel

Fle Edt View Favories Took Help

Qi - © - | Dsewer [ ros |-

Addre:

Panel

Pick a category

Date, Time, Language, and Regional
i

“
B o

(7)) Sounds, Specch, and audio Devices Accessibility Options

Performance ant dMaintenance
4

2. In the Add or Remove Programs dialog box, click Add/Remove Windows Components.

6 Add or Remove Programs

E[=E|

% Currently installed programs:

Change or

i Apple Software Update

Remave ) N
Programs Click here For support information.
T change this program or remave it From your computer,
Addlew & Tnctallation Wizard PE———
Programs

23 Microsoft Office Professional Edition 2003 Size  381.00MB

@ Mozila Firefox (2.0.0.6) See 20.34ME
tddiRemove | 15 Postaresal 8.2 Size  S7.50MB
Cﬁ:‘iﬂg;ts @ QuickTime Sze  74,39MB

) virtual Machine Additions Size  0.90MB

§ vivotek Installation Wizard 2 Sige  G.EOME |

[ vIvoTEK: ST7501 Size  £6.96MB

§5) windows Genine Advantage Validation Tool (KES92130)
@ ‘windowes XP Hotfi - KBB23559
G5 windows xP Hotfix - KB325741
G5 windows 1P Hotfix - KBE33407
G50 windows 1P Hotfix - KB35732
I |

Clase

3. In the Windows Components Wizard dialog box, select Networking Services and click
Details.

Windows Components Wizard

Windows Components
*You can add of remove components of Windaws XP.

To add o remove a component, click the checkbox, & shaded box means that anly
part of the companent will be installed. To see what's included in  component, click

Datails.

Components

[ =2 Message Queving DOME A
M E:

e Other Network File and Print Services X
Wi FA1 Indate Rt Cerifinates nnme_ ¥

Desciiption: Contains a variety of specialized, network-slated services and protacals

Total disk space required, 0.0MB
Space available on disk: 121254 MB

[ <Back [ Mew> | [ Cancdl ]
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4. In the Networking Services dialog box, select Universal Plug and Play and click OK.

Networking Services |X|

To add or remove a component, click the check box. & shaded box means that only part
of the component will be inztalled. To see what's included in a component, click Details.

Subcomponents of Metworking Services:

0.0 MB

"- Universal Plug and Play 0.2 Me I

Description:  Listens for route updates sent by routers that use the Routing Infarmation
Protocol version 1 [RIP«1].

Total disk space required: 0.0ME Detais...
Space available on digk: 121254 MB

i 18 i[ Cancel J

5. Click Next in the following window.

Windows Components Wizard

Windowsz Components
You can add or remove components of Windowes 3P,

To add or remove a component, click the checkbox. & shaded box means that only
part of the component will be installed. Ta see what's included in a companent, click
Details.

Components:

[ 52 Message Queuing 0.0ME #|
¥ SN Explorer 13.5 MB

0.0 MB EJ

1 FEA Indate Rt Cartifizates nnwp_ ¥

Descriptior:  Contains a variety of specialized, network-related services and protocols

Total disk space required: 0.0 ME

Space avalable on disk:
[ < Back Ii Next il[ Canicel J

6. Click Finish. UPnP™ is enabled.

» How does UPnP™ work?
UPnP™ networking technology provides automatic IP configuration and dynamic discovery of
devices added to a network. Services and capabilities offered by networked devices, such as
printing and file sharing, are available among each other without the need for cumbersome
network configuration. In the case of Network Cameras, you will see Network Camera shortcuts
under My Network Places.

» Enabling UPnP port forwarding allows the Network Camera to open a secondary HTTP port on
the router-not HTTP port-meaning that you have to add the secondary HTTP port number to the
Network Camera’s public address in order to access the Network Camera from the Internet. For
example, when the HTTP port is set to 80 and the secondary HTTP port is set to 8080, refer to
the list below for the Network Camera’s IP address.

http://203.67.124.123:8080 http://192.168.4.160 or
http://192.168.4.160:8080

» If the PPPoE settings are incorrectly configured or the Internet access is not working, restore
the Network Camera to factory default; please refer to Restore on page 53 for details. After the
Network Camera is reset to factory default, it will be accessible on the LAN.
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Enable IPv6
Select this option and click Save to enable IPv6 settings.

Please

note that this only works if your network environment and hardware equipment support

IPv6. The browser should be Microsoft® Internet Explorer 8 or 9, Mozilla Firefox 6.0 or above.

— Metwork type

O LAN

@ PPPoE

Username: | |

Password: | |

Confirm password: | |

Enable IPvG

1PvE information
|| Manually setup the IP address

When IPv6 is enabled, by default, the network camera will listen to router advertisements and be
assigned with a link-local IPv6 address accordingly.

IPv6 Information: Click this button to obtain the IPv6 information as shown below.

close

[ethO address]
f280:0000:0000:0000:0202:d1f-feDe:d4cB/64@Link
[Gateway]

IPv6 address list of gateway

[DNS]

IPv6 address list of DNS

If your IPv6 settings are successful, the IPv6 address list will be listed in the pop-up window. The
IPv6 address will be displayed as follows:

Refers to Ethernet

[eth(

address]

|2001:0608:2500:0002-0202:d1F:fe04 6554464 @Glokal —— Link-global IPv6 address/network mask

|££80:0000:0000:0000-0000 1 £ £o04 656464 @Link —— Link-local IPv6 address/network mask

[Gateway]

|feED::211:dEff:feai:132b |

[DNE]

|2D10:05u:ﬂ:9r?3d:: |
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Please follow the steps below to link to an IPv6 address:

1. Open your web browser.

2. Enter the link-global or link-local IPv6 address in the address bar of your web browser.
3. The format should be:

http://[2001:0c08:2500:0002:0202:d 1f:fe04:6 5f4]/

1

IPvé address

4. Press Enter on the keyboard or click the Refresh button to refresh the webpage.
For example:

) Network Camera - Microsoft Internet Explorer

File Edit ‘“iew Fawaorites Tools  Help

‘eﬁack = e & IE @ @I’@Search %Favurites @‘ @' % 4’3

|
Address @ http://[2001:0c08:2500:0002:0202:d1ff:fe04:65f4]/

| Yviversk

WaW,. vwivoTE, Som

@ NOTE:

» If you have a Secondary HTTP port (the default value is 8080), you can also link to the webpage
using the following address format: (Please refer to HTTP streaming on page 83 for detailed
information.)

http://[2001:0c08:2500:0002:0202:d 1ff:fe04:65f4]/:8080

f )

IPvé address Secondary HTTP port

» If you choose PPPoE as the Network Type, the [PPP0O address] will be displayed in the IPv6
information column as shown below.

[ethD address]

|feEO:m03:m03:CC03:Oﬂm:dlffzfell:2299;64@1.1’:1}: |
[ppp0 address]

|££B0:0000:0000:0000:0202:d1 €71 1 229941 0@Link |
|2C01 B 0001 0000200021 £F-Fel 1 229905 @Cchal |
[Gateway]

|feED::93:1a03:4142:8aad |

[DNE]
|20:11 B0 |

Manually setup the IP address: Select this option to manually set up IPv6 settings if your network
environment does not have DHCPvVv6 server and router advertisements-enabled routers. If
you check this item, the following blanks will be displayed for you to enter the corresponding
information:
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Network > Streaming protocols

HTTP streaming

To utilize HTTP authentication, make sure that your have set a password for the Network Camera
first; please refer to Security > User account on page 94 for details.

‘ HTTP streaming ‘ ‘ RTSP streaming ‘

Authentication:
HTTR port
Secondary HTTF port
Access name for stream 1:
Access name for stream 2:
Access name for siream 3:
Access name for siream 4:

Authentication: Depending on your network security requirements, the Network Camera provides
two types of security settings for an HTTP transaction: basic and digest.

If basic authentication is selected, the password is sent in plain text format and there can be
potential risks of being intercepted. If digest authentication is selected, user credentials are
encrypted using MD5 algorithm and thus provide better protection against unauthorized accesses.

HTTP port / Secondary HTTP port: By default, the HTTP port is set to 80 and the secondary HTTP
port is set to 8080. They can also be assigned to another port number between 1025 and 65535. If
the ports are incorrectly assigned, the following warning messages will be displayed:

Microsoft Internet Explorer. _ Microsoft Internet Explorer,

:" } HTTF port must be 80 or From 1025 ko 65535 :" } Secondary HTTP port must be from 1025 to 65535

To access the Network Camera on the LAN, both the HTTP port and secondary HTTP port can
be used to access the Network Camera. For example, when the HTTP port is set to 80 and the
secondary HTTP port is set to 8080, refer to the list below for the Network Camera’s IP address.

http://192.168.4.160 or
http://192.168.4.160:8080

Access name for stream 1 ~ 3: This Network camera supports multiple streams simultaneously.
The access name is used to identify different video streams. Users can click Media > Video >
Stream settings to set up the video quality of linked streams. For more information about how to
set up the video quality, please refer to Stream settings on page 67.

When using Mozilla Firefox to access the Network Camera and the video mode is set to JPEG,
users will receive video comprised of continuous JPEG images. This technology, known as “server
push”, allows the Network Camera to feed live pictures to Mozilla Firefox.
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URL command -- http://<ip address>:<http port>/<access name for stream 1 ~ 4>
For example, when the Access name for stream 2 is set to video1s2.mjpg:

1. Launch Mozilla Firefox or Netscape.

2. Type the above URL command in the address bar. Press Enter.

3. The JPEG images will be displayed in your web browser.

) video2.mjpg (JPEG Image, 320x240 pixels) - Mozilla Firefox

File Edit Yiew History Bookmarks Tools  Help {3

¢ - B - @ @ ﬁl} | http://192.168.5.151 video1s2.mipg ] G-

B Customize Links B Free Hotmail B Windows Media B Windows

Google

A IMPORTANT:

» Microsoft® Internet Explorer does not support server push technology; therefore, using http.//<ip
address>:<http port>/<access name for stream 1 ~ 4> will fail to access the Network Camera.

» Users can only use URL commands to request the stream 5. For more information about URL
commands, please refer to page 173.

RTSP Streaming

To utilize RTSP streaming authentication, make sure that you have set a password for the Network
Camera first; please refer to Security > User account on page 114 for details.

e o [5

Authentication:

RTSP port: T

RTP port for video:

RTCF port for video:

RTP port for metadata:

RTCP port for metadata:

RTP port for audio:

RTCP port for audio:

~ Video

Multicast settings for
IP version:
Multicast video address
Multicast video port:
Multicast video TTL [1~255]

— Audio

Multicast settings:
IP version:
Multicast audio address:
Multicast audio port
Multicast audio TTL [1-255]

. Metad

Multicast settings:
1P version: IPv4 w
Multicast metadata address:
Multicast meladata port:
Multicast metadata TTL [1~255:
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Authentication: Depending on your network security requirements, the Network Camera provides three
types of security settings for streaming via RTSP protocol: disable, basic, and digest.

If basic authentication is selected, the password is sent in plain text format, but there can be potential
risks of it being intercepted. If digest authentication is selected, user credentials are encrypted using
MD5 algorithm, thus providing better protection against unauthorized access.

The availability of the RTSP streaming for the three authentication modes is listed in the following table:

‘Disable 0 o)

‘Basic 0 0
‘Digest o X

Access name for Channel # and stream #: This Network camera supports multiple streams

simultaneously. The access name is used to differentiate the streaming source.

If you want to use an RTSP player to access the Network Camera, you HAVE TO set the video mode to

H.265 or 264 and use the following RTSP URL command to request transmission of the streaming data.

rtsp://<ip address>:<rtsp port>/<access name for stream1 ~ 4>

For example, when the access name for stream 1 is set to live1s1.sdp:

1. Launch an RTSP player.

2. Choose File > Open URL. A URL dialog box will pop up.

3. Type the above URL command in the address field.

4. The live video will be displayed in your player as shown
below.

Open URL

Enter an Intemet URL to open:
| nsp://wz.]68.5.151:554l|i=ve1s1 sdp | v
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RTSP port /RTP port for video, audio/ RTCP port for video, audio

m RTSP (Real-Time Streaming Protocol) controls the delivery of streaming media. By default, the
port number is set to 554.

m The RTP (Real-time Transport Protocol) is used to deliver video and audio data to the clients. By
default, the RTP port for video is set to 5556 and the RTP port for audio is set to 5558.

m The RTCP (Real-time Transport Control Protocol) allows the Network Camera to transmit the
data by monitoring the Internet traffic volume. By default, the RTCP port for video is set to 5557
and the RTCP port for audio is set to 5559.

The ports can be changed to values between 1025 and 65535. The RTP port must be an even
number and the RTCP port is the RTP port number plus one, and thus is always an odd number.
When the RTP port changes, the RTCP port will change accordingly.

If the RTP ports are incorrectly assigned, the following warning message will be displayed:

Microsoft Internet Explorer

"' } Invalid port number, RTP video port must be an even number,

b

Multicast settings for stream #1 ~ #3: Click the items to display the detailed configuration
information. Select the Always multicast option to enable multicast for streams #1 ~ #3.

— Video

Multicast settings for eam 1 v
IF version:
Multicast video address: .240.7.99
Multicast video port:

Multicast video TTL [1~255]:

3 5 5 B [7 2
= <

— Audio

Multicast settings:
IP version:
Multicast audio address: .240.7.99
Multicast audio port: 15562
Multicast audio TTL [1~255]:

— Metadata

Multicast setlings:
IP version:
Multicast metadata address:
Multicast metadata port
Multicast metadata TTL [1~255]:
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Multicast settings for streams: Click the items to display the detailed configuration information.
Select the Always multicast option to enable multicast for video streams.

— Video
Multicast settings for

IF version:
Multicast video address: .240.7.99
Multicast video port;

Multicast video TTL [1~255]:

— Audio
Multicast settings:

IF version:
Multicast audio address: .240.7.99
Multicast audio port:

Multicast audio TTL [1~255]:

— Metadata

Multicast settings:
IP version:
Multicast metadata address:

Multicast metadata port:

HEIE I =38 78
gmh z w
¥ [c :
~
© <

Multicast metadata TTL [1~255] 1

Unicast video transmission delivers a stream through point-to-point transmission; multicast, on the
other hand, sends a stream to the multicast group address and allows multiple clients to acquire
the stream at the same time by requesting a copy from the multicast group address. Therefore,
enabling multicast can effectively save Internet bandwith.

The ports can be changed to values between 1025 and 65535. The multicast RTP port must be an
even number and the multicast RTCP port number is the multicast RTP port number plus one, and
thus is always odd. When the multicast RTP port changes, the multicast RTCP port will change
accordingly.

If the multicast RTP video ports are incorrectly assigned, the following warning message will be
dISplayed. Microsoft Internet Explorer

E! E Tnvalid port number, Multicast stream 1 vidso port must be an even number,

Multicast TTL [1~255]: The multicast TTL (Time To Live) is the value that tells the router the range
a packet can be forwarded.

Initial TTL Scope

0 Restricted to the same host

1 Restricted to the same subnetwork
32 Restricted to the same site

64 Restricted to the same region

128 Restricted to the same continent
255 Unrestricted in scope

A IMPORTANT:

The Multicast metadata port is utilized by VIVOTEK VADP modules to transfer video analytics
results, PTZ stream, textual data, and event messages between the camera and the client side
running and observing the video analysis. If your client side computer is located outside the local
network, you may need to open the associated TCP port on routers and firewall.

User's Manual - 89




VIVOTEK

Network > DDNS

This section explains how to configure the dynamic domain name service for the Network
Camera. DDNS is a service that allows your Network Camera, especially when assigned
with a dynamic |IP address, to have a consistent host and domain name.

Express link

Express Link is a free service provided by VIVOTEK server, which allows users to register
a domain name for a network device. One URL can only be mapped to one MAC address.
This service will examine if the host name is valid and automatically open a port on your

router. If using DDNS, the user has to manually configure UPnP port forwarding. Express
Link is more convenient and easier to set up.

J Express link | | Manual setup

Enable express link

hittp:/f | | 2bthere.net Help P—

By Express link, all users need to do is create host name for the camera. It will generate the link to
access the camera from internet.

Please follow the steps below to enable Express Link:

1. Make sure that your router supports UPnP port forwarding and it is activated.
2. Check Enable express link.

3. Enter a host name for the network device and click Save. If the host name has been used by
another device, a warning message will show up. If the host name is valid, it will display a
message as shown below.

Express link | | Manual setup

[¥] Enable express link

hitp:/l 0002D1123456 -2othere.net Helo  sae |

The ciamera can now be accessed at hitp:/000201123456.2bthere.net

2§ Network Camera - Microsoft Internet Explorer

File Edit Wiew Favorites Tools  Help

°Back - @ - Ia @ @ pSearch 'ﬂfFavorites @‘ @' % 43
| &) hitps://0002D1123456.2bthere.net
%:mgﬁ Mega-Pixel Network Camei
mmljl iEAuhD-B SO%iB 25%'
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Manual setup

DDNS: Dynamic domain name service

— DDNS: Dynamic domain name service

[] Enable DOMNS:

Provider: | Dyndns.org(Dynamic) @|

Host name: | |

User name: | |

— ]

Enable DDNS: Select this option to enable the DDNS setting.

Provider: Select a DDNS provider from the provider drop-down list.

VIVOTEK offers Safe100.net, a free dynamic domain name service, to VIVOTEK customers. It
is recommended that you register Safe100.net to access VIVOTEK’s Network Cameras from the
Internet. Additionally, we offer other DDNS providers, such as Dyndns.org(Dynamic), Dyndns.
org(Custom), TZO.com, DHS.org, CustomSafe100, dyn-interfree.it.

Note that before utilizing this function, please apply for a dynamic domain account first.

m Safe100.net

1. In the DDNS column, select Safe100.net from the drop-down list. Click | accept after reviewing
the terms of the Service Agreement.

2. In the Register column, fill in the Host name (xxxx.safe100.net), Email, Key, and Confirm Key,
and click Register. After a host name has been successfully created, a success message will
be displayed in the DDNS Registration Result column.

— Register
Host name: |WTK.bafe‘l{]U.net| |
Email: |Mk@wvctek.com |

Key: wene Farget key
conti ke -

To apply for a domain name for the camera, or to modify the previously registered infarmation, fill in

the following fields and then click "Reqgister”.

DDME Registration Result:

[Register] Successfully Your account information has
been mailed to registered e-mail address

LAEY

Upon successful registration, you can clickmo automatically upload relevant information to the

DOMNS form or you can manually fill it in. Then, click "Save” to save new settings.

3. Click Copy and all the registered information will automatically be uploaded to the corresponding
fields in the DDNS column at the top of the page as seen in the picture.
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— DDN5: Dynamic domain name service

Enable DDNE:

Provider: |Safe1{]0.net Dg|

Host name: |WTK.safe‘|ﬂU.net | [*.safe100.nef]

Email: wik@vivotek.com
o -

— Register
Host name: |WTK.safe‘|ﬂU.net |
Email: |w1k@v1vctek.com |

Key: rene Forget key
Conti ey -

To apply for a domain name for the camera, or to modify the previously registered information, fill in

the following fields and then click "Register”.

DDMNS Reagistration Result:

[Register] Successfully Your account information has
been mailed to registered e-mail address

[0

Upon successful registration, you can click copy to automatically upload relevant information to the

DDMS form or you can manually fill itin. Then, click "Save™ to save new settings.

4. Select Enable DDNS and click Save to enable the setting.

m CustomSafe100

VIVOTEK offers documents to establish a CustomSafe100 DDNS server for distributors and
system integrators. You can use CustomSafe100 to register a dynamic domain name if your
distributor or system integrators offer such services.

1. In the DDNS column, select CustomSafe100 from the drop-down list.

2. In the Register column, fill in the Host name, Email, Key, and Confirm Key; then click Register.
After a host name has been successfully created, you will see a success message in the DDNS
Registration Result column.

3. Click Copy and all for the registered information will be uploaded to the corresponding fields in
the DDNS column.

4. Select Enable DDNS and click Save to enable the setting.

Forget key: Click this button if you have forgotten the key to Safe100.net or CustomSafe100. Your
account information will be sent to your email address.

Refer to the following links to apply for a dynamic domain account when selecting other
DDNS providers:
m Dyndns.org(Dynamic) / Dyndns.org(Custom): visit http://www.dyndns.com/
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Network > QoS (Quality of Service)

Quality of Service refers to a resource reservation control mechanism, which guarantees a certain
quality to different services on the network. Quality of service guarantees are important if the
network capacity is insufficient, especially for real-time streaming multimedia applications. Quality
can be defined as, for instance, a maintained level of bit rate, low latency, no packet dropping, etc.

The following are the main benefits of a QoS-aware network:
m The ability to prioritize traffic and guarantee a certain level of performance to the data flow.

m The ability to control the amount of bandwidth each application may use, and thus provide higher
reliability and stability on the network.

Requirements for QoS

To utilize QoS in a network environment, the following requirements must be met:
m All network switches and routers in the network must include support for QoS.
m The network video devices used in the network must be QoS-enabled.

QoS models

CoS (the VLAN 802.1p model)

IEEE802.1p defines a QoS model at OSI Layer 2 (Data Link Layer), which is called CoS, Class of
Service. It adds a 3-bit value to the VLAN MAC header, which indicates the frame priority level from
0 (lowest) to 7 (highest). The priority is set up on the network switches, which then use different
queuing disciplines to forward the packets.

Below is the setting column for CoS. Enter the VLAN ID of your switch (0~4095) and choose the
priority for each application (0~7).
— Cos

[#] Enable Cos

o .

Live videa: o -
Live sudia: D_"
Event/Alam: D_"'
Management: D_"

If you assign Video the highest level, the switch will handle video packets first.

ﬁ NOTE:

» A VLAN Switch (802.1p) is required. Web browsing may fail if the CoS setting is incorrect.

P The Class of Service technologies do not guarantee a level of service in terms of bandwidth
and delivery time; they offer a "best-effort." Users can think of CoS as "coarsely-grained” traffic
control and QoS as "finely-grained"” traffic control.

» Although CoS is simple to manage, it lacks scalability and does not offer end-to-end guarantees
since it is based on L2 protocol.
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QoS/DSCP (the DiffServ model)

DSCP-ECN defines QoS at Layer 3 (Network Layer). The Differentiated Services (DiffServ) model
is based on packet marking and router queuing disciplines. The marking is done by adding a field
to the IP header, called the DSCP (Differentiated Services Codepoint). This is a 6-bit field that
provides 64 different class IDs. It gives an indication of how a given packet is to be forwarded,
known as the Per Hop Behavior (PHB). The PHB describes a particular service level in terms of
bandwidth, queueing theory, and dropping (discarding the packet) decisions. Routers at each
network node classify packets according to their DSCP value and give them a particular forwarding
treatment; for example, how much bandwidth to reserve for it.

Below are the setting options of DSCP (DiffServ Codepoint). Specify the DSCP value for each

application (0~63).

— QoS/DsSCP
[#] Ensble QoS/DECF
Live video:
Live audio:
Event'Alam:

Management:

CE
R
]
LI

Ingress DSCP | Output Queue Ingress DSCP | Output Queue

Ingress DSCP | Output Queue

Note that different vendors of network devices might have different methodologies and unique
implementations. Shown below is a sample corresponding information from a Cisco switch. You
should enter a DSCP tag value according to the information provided by the network devices.

Ingress DSCP | Output Queue

0(BE) 1w 16(CS2) 2v 32(CS4)

1 1w 17 2w 33

2 1w 18(AF21) 2v 34(AF41)

3 1w 19 2v 35

4 1w 20(AF22) 2v 36(AF42)

5 1w 21 2w 37

3 1w 22(AF23) 2v 38(AF43)

7 1w 23 2v 39
B(CS1) 1w 24(CS3) av 40(CS5)
[ 1w 25 av 41
10(AF11) 1w 26(AF31) v 42
1 1w 27 3v 43
12(AF12) 1w 28(AF22) av 44
13 1w 29 v 45
14(AF13) 1w 30(AF33) av 46(EF)
15 1w 31 av 47

CQueue 1 has the lowest priority, queue 4 has the highest priority.

[
-

w
-

w
-

[
-

w
-

s
-

.
-

.
-

s
-

.
-

.
-

s
-

.
-

3r 4B(C56)

49

51

52

53

55

56(CST)

57

59

61

62
63

(oo | ,Gancel] | Resiore Detauts |

QoS/DSCP

Enable QoS/DSCP

| tive viaso: 320 |
Live audio: 0
Eventasam: P ]
wanagement L

QoS Baseline/Technical Marketing Classification and Marking Recommendations

Application Layer3 Classification Layer 2 CoS/MPLS EXP
IPP PHB DSCP

IP Routing 6 CS6 48 6

Voice 5 EF 46 5

Interactive Video 4 AF41 34 4 QoS B

Streaming-Video 4 CS4 32 4

Locally-defined Mission-| 3 - 25 3

Critical Data

Call-signaling 3 AF31/CS3 26/24 3

Transactional Data 2 AF21 18 2

Network Management 2 CS2 16 2
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Network > SNMP (Simple Network Management Protocol)

This section explains how to use the SNMP on the network camera. The Simple Network
Management Protocol is an application layer protocol that facilitates the exchange of
management information between network devices. It helps network administrators to
remotely manage network devices and find, solve network problems with ease.

m The SNMP consists of the following three key components:

1. Manager: Network-management station (NMS), a server which executes applications that
monitor and control managed devices.

2. Agent: A network-management software module on a managed device which transfers the status
of managed devices to the NMS.

3. Managed device: A network node on a managed network. For example: routers, switches,
bridges, hubs, computer hosts, printers, IP telephones, network cameras, web server, and
database.

Before configuring SNMP settings on the this page, please enable your NMS first.

SNMP Configuration

Enable SNMPv1, SNMPv2c
Select this option and enter the names of Read/Write community and Read Only community
according to your NMS settings.

Enable SNMPy1, SNMPvZc

SHMPv1, SNMPv2c Settings

Read/\Write community: |F'rivate |

Read only community: |Pub|ic |

Enable SNMPv3
This option contains cryptographic security, a higher security level, which allows you to set the
Authentication password and the Encryption password.

m Security name: According to your NMS settings, choose Read/Write or Read Only and enter the
community name.

m Authentication type: Select MD5 or SHA as the authentication method.
m Authentication password: Enter the password for authentication (at least 8 characters).

m Encryption password: Enter a password for encryption (at least 8 characters).
Enable SNMPv3

— SNMPv3 Settings

Read/Write Security name: |Private |

Authentication Type:

Authentication Password: | |

Encryption Password: | |

Read only Security name: |F‘Ub|iC |

Authentication Type:

Authentication Password: | |

Encryption Password: | |
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Network > FTP

The newer firmware may disable the FTP port for security concerns. You can manually enable the
FTP server service to enable the FTP function.

FTP port: The FTP server allows the user to save recorded video clips. You can utilize VIVOTEK's
Installation Wizard 2 to upgrade the firmware via FTP server. By default, the FTP port is set to 21.
It can also be assigned to another port number between 1025 and 65535.

-"- Tips:

You can FTP the camera’s IP address to download videos recorded in the SD card, or use the “http://
ip/cgi-bin/admin/Isctrl.cgi?cmd=search” command to examine the recorded files on your SD card.

96 - User's Manual




VIVOTEK

Bonjour

To access the camera from a Mac computer, go to Safari, click on Bonjour and select the camera
from a drop-down list.

You can go to Safari > Preferences to enter your user name and password, and provide the root
password the first time you access the camera. The camera main page will open in your browser.

ece Discovery

¥ local - 6 items
¥ _atpovertcp._tcp. (AFP over TCP)
» _companion-link._tcp.
¥ _csco-sb._tcp.
¥ _nttp._tep. (World Wide Web HTTP)
¥ _risp._tep. (Real Time Streaming Protocol (RTSP)) - 1 items
Network-Camera.local.
192.168.0.15:554
path=live.sdp
¥ _smb._tcp. (Server Message Block over TCP/IP)

Some later iOSes may come without the Bonjour option. Install the Discovery utility instead.

Find the Discovery (formerly Bonjour Browser) from the Mac App Store.

Discovery is a utility that displays all the Bonjour services on your local network or on Wide-Area
Bonjour domains. The utility is previously called Bonjour Browser, it is now distributed on the Mac

App Store.

Discovery requires macOS 10.12 or higher. For older versions of Mac OS you can download the
old version of Bonjour Browser.

Bonjour Browser (obsolete)
http://www.tildesoft.com/files/BonjourBrowser.dmg - Version 1.5.6

Discovery for iOS
https://itunes.apple.com/us/app/discovery-dns-sd-browser/id3054410177?mt=8
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Security > User accounts

This section explains how to enable password protection and create multiple accounts.

Account management

Security > User accounts

| Account management | | Privilege management |

[--New user— v
User name: |fr0nt t_guard |
User password: |a-n.a--.a-n.a- | Medium

* At least 8 characters with no space, one alphabet character and one numeric character

Confirm user password: |----------un |
Privilege: v
[ Deete | Aad [ Update |

The administrator account name is “root”, which is permanent and can not be deleted. If you want

to add more accounts in the Account management window, please apply the password for the “root”
account first.

The administrator can create up to 20 user accounts.

To create a new user,

1. Click to unfold the pull-down menu. Select New user.

2. Enter the new user’s name and password. Type the password identically in both text boxes.

Some, but not all special ASCII characters are supported: !, $, %, -, ., @, », _, and ~.
You can use them in the password combination.

The strength of your password combination is shown on the right, use the combination of

alphabetic, numeric, upper case, and lower case characters until the password strength is good
enough.

3. Select the privilege level for the new user account. Click Add to enable the setting.
The privilege levels are listed below:

Administrator |Full control

Operator Control DO, white-light illuminator, snapshot, and PTZ;
unable to enter the camera Configuration page.
Viewer Control DO, white-light illuminator, view, listen, PTZ, and talk through the

camera interface.

Access rights are sorted by user privilege (Administrator, Operator, and Viewer). Only
administrators can access the Configuration page. Although operators cannot access the
Configuration page, they can use the URL Commands to get and set the value of parameters. For
more information, please refer to URL Commands of the Network Camera on page 163. Viewers
can only access the main page for live viewing.

Here you also can change a user’s access rights or delete user accounts.
1. Select an existing account to modify.

2. Make necessary changes and click Update or Delete to enable the setting.
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Privilege management

|Ac::0unt management ‘ ‘ Privilege management |

] Allow anonymeous viewing
Operator: Digital output PTZ control
Viewer: [] Cigital output PTZ control

Digital Output & PTZ control: You can modify the management privilege as operators or viewers.
Select or de-select the checkboxes, and then click Save to enable the settings. If you give Viewers
the privilege, Operators will also have the ability to control the Network Camera through the main
page. (Please refer to Configuration on page 57).

Allow anonymous viewing: If you select this item, any client can access the live stream without
entering a User ID and Password.
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Security > HTTPS (Hypertext Transfer Protocol Secure)

This section explains how to enable authentication and encrypted communication over
secure connection. It helps protect streaming data transmission over the Internet on higher
security level.

Create and Install Certificate Method

Before using HTTPS for communication with the Network Camera, a Certificate must be created
first. There are three ways to create and install a certificate:

Create self-signed certificate

1. Select this option from a pull-down menu.

2. In the first column, select Enable HTTPS secure connection, then select a connection option:
“‘HTTP & HTTPS” or “HTTPS only”.

3. Click Create certificate to generate a certificate.

— HTTPS
Enable HTTPS secure cennection
“* Mode:
@ HTTP &HTTPS ) HTTPS only
Pleaze wait while the certificate is being

~ Cerificate: generated...
Certicate information o _____|
Status: Not installed
method: | Create self-sianed certificate =
Country:
State or province: |Asia |
Locality: Asia |
Organization: VIVOTEK Inc |
Organization unit: |VN'0TEK.Inc |
Comman name: | www.vivotek.com |
Validity: days

4. The Certificate Information will automatically be displayed as shown below. You can click Certifi-
cate properties to view detailed information about the certificate.

Certificate information

Status: Active

method: Create self-signed certificate
Country: W

State or province: Asia

Locality: Asia

COrganization: VIVOTEK.Inc

Organization unit: VINOTEK.Inc

Common name: www vivotek.com

Certicate roperes
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5. Click Save to preserve your configuration, and your current session with the camera will change
to the encrypted connection.

6. If your web session does not automatically change to an encrypted HTTPS session, click Home
to return to the main page. Change the URL address from “http://” to “https://“ in the address bar
and press Enter on your keyboard. Some Security Alert dialogs will pop up. Click OK or Yes to
enable HTTPS.

https://

2 Network Camera - Microsoft Internet Explorer

File  Edit

jiew  Favorites  Tools  Help
GBack < @ @ @ @ pSearch if}?Favorites e‘ @v % 4’3
Addres: ahttps://192.168.5.151/index.htm|

a VIVOTEK Mega-Pixel Network Camera
. - =1 BT Client settings | Configura

& Manual triggers:
Digital output:

Focus assist: [ on JoR

PTZ control:  Digital :

e |

M aecutlty hlect fad
2l
[ =] Zoom | 4] x o g “'ou are about to view pages over a secure connechion.

mm Patrol R ~ I Any information you exchange with this site cannot be
e - 0 - 4 o . viewed by anyone else on the Web.
Tilt speed: [ 4 5 o = [ n the future, do rot show this waming
LTS o - y i Ok, i [ are Info ]
~ Global view: . i
Security Alert Security Information |§|
ri"l Information you exchange with this site cannot be viewed or riril Thiz page contains both secure and nonzecure
?. changed by others. Howewer, there iz a problem with the site’s ?. items.
: zecurty certificate, :

Do pou want to dizplay the nonsecure items?
The zecurity certificate was izsued by a compary vou have
niob chosen bo trust. Yiew the certificate to determineg whether
you want to trust the certifying authority.

E Tes ” Mo J[ bare Info ]

a The zecurity certificate date iz walid.

& The name on the security certificate iz invalid or does not
match the name of the site

Do you veant bo proceed’?

[ Yes ] L Mo i [View Eertificate]
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Create certificate request and install

1. Select the option from the Method pull-down menu.

2. Click Create certificate to proceed.

3. The following information will show up in a pop-up window after clicking Create. Then click Save
to generate the certificate request.

< Certificate:
Cefrtificate information
Status: Not installed
Method: | Create certificate request and install E||
Country:
State or province: |nsia |
Locality: |a5|a |
Organization: | VIVOTEK Inc. |
Organization unit: |VIVOTEK Inc. |
Commaon name: |www.v1\f0tekcorn |

Please wait while the certificate is being

4. The Certificate request window will prompt.

€ htip://192.1¢

— Create certificate request completed

Copy the PEM format request below and send it to a CA for identify validation. After that, you have to install it
by clicking the "Upload™ button on HTTPS page.

— Certificate req {PEM

BEGIN CERTIFICATE REQUEST-———-—
MITBs=CCARWCAQIwozELMAKCAI UEBhMCVF cxDTALEgNVBAGTEEFzaWExDTALEGHN Y
BACTBEFzZaWEXFIATE oTIDFZJVkIURU: JLIEVMBMGRIUECXMMVEKIWT1RF
SyB OV 3cudml 2h3R1ay5 b2 0wgZEwDOY TEoZ ThveNAQER
BRADGY0OAMICIRAoCBALEFSjkjhlCcufOHpd 3£0HUngCEPLQ8zi B 4HCTbr svhpun/W
ADZJRAYEHShLOwEpmpsMy3crSYtulJuGTbkbLAUHN/ T3 7RAvVZAUCOXEvIMSAgZISI e
ZpnCIZP¥59L244VnhuairewvwR1VHONEixf1lodDZUEKmC3UHBpNLBES IS TvASAgME
BREgADANEgkghkiGIwlBAQUFAROBgRBAQgpKdUL chbwd 1 REnEUSEEMEnBr i KHmQY
rk/iglTELEXPWESKRALgi3I4XpFN]AVBUs0LwUCOCh/ nyHRScZaZ tEZWiSJhD1ALIFm
IZXNPLIAvCA6220hobqT9e SILEEVL lwClpRXNmoEulgNz dM¥VyzRgd3zoeQuZsSVz
SMxxriluow=—

————-END CERTIFICATE REQUEST--————

If you see the following Information bar, click OK and click on the Information bar at the top of
the page to allow pop-ups.

3 HTTPS - Microsoft Internet Explorer

File Edit Wew Faworites Tools Help

Qi © X B G P frrwone @ 2- 258

Address @ httpi//192,168.5, 151 fsetup/https. html
& Pop-up blacked, To see this pop-up or additional options click here. ..

Home Qe liil[NeVGLE Language

)
L=ty > HTTPS

System

Information Bar,

Security Did you notice the Information Bar?
User account The Information Bar alerts you when Intemet Explorer blocks a
pop-up windaw ar file download that might nat be safe. If &

HTTPS ‘web page doss not display properly, look far the Information
Bar (near the top of your browser)

Access list

|EEE 802.1% (] Do not shaw this message again.

[r— Leamn about the Information Bar.
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5. Look for a trusted certificate authority, such as Symantec’s VeriSign Authentication Services,
that issues digital certificates. Sign in and purchase the secure certification service. Copy the
certificate request from your request prompt and paste it in the CA’s signing request window.
Proceed with the rest of the process as CA’s instructions on their webpage.

i e AL Svmentec rust Center e, B_ﬁ

Help & Support | Feedback

@Symantec. Trust Center
___________________________________________________________________|
Free Trial > 1)Cptions = 2) Techrical Cortact 3= 3)CSR = 4) Sumimary ChaIAWIIIhU: - l

Enter Certificate Signing Request (CSR)

Server platrorm: & Sample CSR Order details
Selectone hd Symantec™ SSL Test Certificate

» Walidity period: 30 days

St A
S aE e ;

401 DTN VR ZIZ KM L Jod VINES Oy 2T WES M Total: (Free Trial) us fo
,,,,, BT GATE nEoUEST

Paste Certificate Signing Request (CSRy: &

MIBS]CCARSCAGIWEELMA kG A1 LESHMCYF cxDT ALBgNYB AGTBEF 28V EXDTALBNY
Bt TEEF 28 WEF TA TEghYERA 0 TDF Z)VkSURUsgEWSILIEY MBMG A1 LECMMVKIATI RF . "
B. QYDVQED MLIAMTCyLmivbT CBriz ANBkhKIGSw B AGEF @ Whatis a CSR?
OB AWV VEAZITS 2y 29 LBEDT R+ Dok LINL cirva260H sef 20V 3pS
E1Gn+HEGOG2NREDEL shDF QEEEANIDE gEGhCI 2SR O H CKYEEYOXGZGRI A CSR is generated fram your server and is
S HCLGT P B P ST IS SR Q25 gmoCFefRaS2aphiCAWE S your server's unique "ingerprint’. The CSR
1GSh3DEEEEGELU. Gk Icr GRS hD2PSlbk4LIOF TRSGimAr includes your server's public key, which
TRACvrELEImgSY 2aNzVECyZalEY PRDGZRGLYAUOWI Py Boe Y 329B0JHSIOf enables server athentication and secure
DG HRPIMG 3K DSIME] ANIBC 25T 7 aPiphNGEF by communication
Y2 Mz he ceneratin 8 CSR? ==
-END CERTIFICATE REGUEST -
Total: US 0 (Free Trial) < Back Cancel Continue

TRUSTe Gt

| pone =

6. Once completed, your secure certificate should be delivered to you via an email or other means.
Copy the contents of the certificate in the email and paste it in a texttHTML/hex editor/converter,
such as IDM Computer Solutions’ UltraEdit.

immediately, please dial 866.893.6565 or 650.426.5112 option 3 or send an email to internet-sales@verisign.com

Thank you for your interest in Symantec!

MIIFBDCCA+yaRWIBRQIQFx1Cahn/S5eBSit0WQDOBIzANEgkghkiGIw0BAQUFADCE
yZELMAkGA1UEBhMCVVMAFZAVBQNVBA0TD1Z 1cml TaWdu LCBIbmMuM T AWLgYDVRQL
EydGb3IgVeVzdCBQdEJwb3N1cyBFbmx SLiAgTMEgYXNZdXJhbrN1cy4xQ] BABQNV
BASTOVR1cmlzIG9mIHVZZ5BhdCBodHRwez0vL3d3dy52ZXdpc21lnbi5]b20vY3Bz
L3R1c3R] YSAoYykwOTEtMC3GA1 UEARMKVIVyaVNpZ 2 4gVHIpYiwg 2V dXJ1 TFN1
cnZlciBDQSAtIEcyMB4XDTEyMDcwMz AwMDAWMFoXDTEyMDgwMj IzNTk10Vowgadx
CzAJBgNVBAYTA] REMQOWCWYDVQRTEWREC2 1 hMQOWCW Y DVQHFAREC2 1 hMRIWEWYD
VOQKFAXWSVEZEVEVLIEluYy4xFTATBQNVEASUDFZ JVk SURUsgSWSLIEGMDgGRIUE
CHQRVEVYbXMgh2 YgdiN1 IGF0THA3dy52 2K Ipc21nbi5 b2 0vY 3BZL3R1 c3R] Y54n
¥ykwNTEXMBUGALIUERAxQOd3d3LmZ 10DE 3Mi55b2 0wgZ EwDQY JKoZ ThwcNAQEEBQAD
g¥ORMIGJIAGGRANI TEOtr8KGTeC+hAIUYFrgeXZCyTS3a T2 tunRyLEpdlid6eodR.
p/h+ajhtpIUQg5CT INwxUBBCEFp/ Q4 x I FBoQPWUGS0Z 0GR/ gqgimARK] LxsxkFH/R
Wx1IKSnlzwhkloCDygrFEZRSCMOvI45GDrEbRSkNuoMpgRhXo0KoOnggTAgMBARG]
QgOGEMIIBITAZEgNVHREEE] AQgg53d3cuZml4MI cyLmNvbTAJEQNVERMEL J ARMALG
R1UdDWEB/wQEAWIFoDBDBgNVHR2EPDAEMDigNgROh] JodHRWOiSvI1ZSVHIpY Wt
RzItY¥3JslnZlcmlzaWdulmNvb59TV1JUcmlhbEcyLmNybDEKBQNVHSAEQZEEMDEG
CrCESAGE+EURBXTWMT AvEggrBgEFBcCARY § aHRO cHMALy 9 3d 3cudrVyaipZ24u
¥29tL2NwcyI0ZXNOY 2EWHQYDVRO1BEYWEAY IKWYBBQUHAWEGCCaGAQUFBWMCMBEG
R1UdIw)YMBaAFCoXE4q91qK] 3AY=t7a02hBnYG7 IMEQGCCaGAGUFEWERRGWE Ak
BggrBgEFBQCowAYYYaHROcDovL29] c3AudnVyaXNpZ 24u¥29tMD4GCCaGAQUFBAC
hjJodHRwOiEvULZSVHEIpYRwtRzItYWlhLnZ loml zaWdulovb STVl JUcmlhbEcy
LmN1cjANBgkahkiGOwOBAQUFAROCAQERTXUHTFnIae/X7T62/ 22r9ZEKNLESEQSD
qaNcEawinSclZ9Fp3kzEKvpaICLEFSMbrOPGIPalLFXAEUITr SW1SCoXRR1AIWpl2
qVSbDExgVMRX9T Trd20URzims6i feM5Ttub3Qc2Tu3pRe AKbAH/ T+x+0] GOEVB3zZ
cPaShn/gcapKcqlXvHycwHeCWNERQaGci368qkPzasvToErbnLhupjdxUESGExU
IM13CErAtQZviRad]l fIQYSTgS0Ng2mA SghdEuKTnhCHUwwgOxNBuce ITE3ITPKTO
meCo¥YpntblgmFey] 9EvgIUdceYZImn2B0qScSq3iZARPH/ gl/f /EeGg=—=
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7. Open a new edit, paste the certificate contents, and press ENTER at the end of the contents to
add an empty line.

@ [Edit1#] - UltraEdit 10l x|
File Edit Search Insert Project Wiew Formabt Column Macro Scriphing  Advanced  Window Help
e e eE e e EEEE BEEB @Y
g
ijactl open  Explorer |Lists | A1) Editl % g
1| =
Filter: I * > IID I
I
w1 A oo 10 o 201 30 0 BB BB E
e 12 [ CCGEAGG+EUBExUvNTAvEggr BgEFBQoCARY JaHROcHMALy93di cudnWyaNp 22 4u
et 15 (¥29tL2Nweyd0 ZENOY2 EwHQYDVRO IBEYwF AY IKwYEBQUHAWE GC CaGAQUFEwMCMESG =
? E . 20 |A1TdIWQTHEaLF CoXE4qo1gK13 A¥at 7a02 hBMYGT7 LMHQGCC2GLOUF BWEBEGoWE ] Lk =
% F':;"";’ . 21 |BgurBYEFBQew LYY YaHROeDovL2 99 03 AudniiyaXin 22 4uY2 9t HD4GCCSGLOUF Bz AC 2
-
ceounes 22| by JodHRWO1EvT1ZSVHIpYHWE Rz It TW1ALYNZ Loml zaWdulmlivh 39 TV 1 JUcml hhE ey 2
22| L 1o J ANBgkghkiGoOwOB AQUF AROC AQEATHuHYFnIae,/ X7T6z/ 22r 92EEhLESEQSp =
Z4 |gqalcEswidic1Z9P p3keEEvp 6 TCLPSMbrOPGI PRl LFx AEUITr3 W1SCoXWRIAUp 12 |
25| qVSbD fxgVHiTx 9 T7rd2 0URz jms 6 i foM5 Thub3 0o 2 Tud pile AKb AH/ T+x+0] G0EVES = —
26 |cPaShn/ qeapKeg0XvHyc wHe CUNEROgsGe 13 65gkPessvToErbnLhup jdx UESGExu g
27 [3MLGCEC ACQEviRadlfJOT STyl 0NgZ mASghdEuKTnhC HUluvwgOxN8uce IIS3 ITPETD =
4 Name Date modifiec A ) . T
mECoTpnthlowF ety 9EvgIUde 6 YE Inn2 BOgSe 53 iZARPH gi/ f EeGg== Z
(=
=
=
=
o
5
o}
3
< | | -

8. Convert file format from DOS to UNIX. Open File menu > Conversions > DOS to Unix.
(@ [ viabdie R =

File Edit Search Insert Project View Format Column Macro  Scripting  Advanced Window Help

[ tew Gt BT RER EEEE OB @S
& Open... Chl+O
¥ Quick Open... Chr+0) =
Close =
-]
05 Closs Al Flles Chel+Shift+F4 2
@ Close All Files Except This %
¢ o
FIP{Telnet v I L S ) L S L A . | L W] LA ) P . =
= GEAGG+HEUBExUwMTAYVEygrBgEFEQuCARY jaHROcHMELy93d3 cudVyaXNp 22 4u
@ Revert bo Saved CLZNweyI0 ZENO0 Y2 EwHQYDVED1BEYTwEF AY IKw TEBQUHAWE GC C s GAQUFBEwHCMESG =
IwQTHEaAF CgXE4o9 1K1 AYst 7a02 hBn Y67 IMHQGCCsGAQUF BwEBBGywE S Ak =
B save Chrkts rEgEFEQewAYTYaHEROeDovL2 0 el Audnyaip 22 4u¥2 0eHD4GCCsGAQUF B AC g
E Save As... Fiz odHRwOi8vT1Z3VHEIpTwt Rz It TU1hLnZ leml ealdulnlvh 38TV 1 Ul hbEcy E
% Save All Al+F12 1o ANBgkahkiGOwOBAQUFALOC AQEAT®uH?Fnlae/ X7T6e/ z2r 92 EKWLESEQSp &
a i Salaction £ Cc8swikSelIoPpikeERvp 6TCLPSMbrOPGIPalLFxAEUITE3WISCoXWRLIAIUp 12
- - - D ERgW MO T7rd2 oURz jms 6 ifeMETEwo3 Qo2 Tul pe kb AR/ T+x+0jGOEVEI = ]
% () i Shn/ gqoapKeg0ivHyc wHe CUNERQg=sGe 13 68kPzssvioErbnLhup Jdx UESGExu Lgn
Encryption P PCErACQZviRadlfJOYSTgI0NgZmASghdEuKTnhCHUwyqOXxNEuce IIS3 ITPKYD ?
3 ; TpnthlonFtyi9EvgIUdesYEInn2 BOgSeSqg3 iZARPHS gi/ / XeGg== @
= Benemer __END CERTIFTCATE-————
(& Compare... AlE+F1L =
Sotk 3 E
LUNIZMAC to DOS =
o
Special Functions » B DOS to MAC EE
il
Print... Chrl+P -
Print All Files % EBCDIC ko ASCIT =
Print Preview % ASCII ko EBCDIC
Print Setup/Configuration 3 % OEM ko ANST
E Favarite Files... Chrl+Shift+F % ANST ko OEM
agmnt s » 5 ASCIIto Unicode
Recent Projects/\WorkSpace Y B (T b Unicode
B e ™ Uricode b A5CIL
r
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9. Save the edit using the “.crt” extension, using a file name like “CAcert.crt.”

File Edit Search Insert Project Wiew Format Column Macro  Scripbing  Advanced  window  Help

@& B REE

53 e N s n!z

i My Documnents &UItraCompare
: a My Computer @UltraEdit
& My Network Places & YTYOTEK
= i Adobe Reader 9 ) BlackholePmzs AR (13 Blackhole)
S DI: K74 FileZila Client [Ty Mew Folder
g 'E ¥ Google Chrome 44
N;atwork e Installation Wizard 2 @45
FTF &ccounts 5 LiveClient 46
McAfee Security Scan Plus 802. 1
ap Milestane ¥Probect Smart Client 802. 1x-1
B Mozilla FireFax [ s0z.1%-2

% Playback.

(A QuickTime Player
£ RealPlayer @activerlugin
] Teamviewer & @activerluginl

A Name I Drate modifisc

i

Save I
Cancel |

File name: IC.*’-\celt.crt

Save as type: IAII Files, "]

L L L

Line Terminator: IDeFaU":

Format: IDEFauIt

Kl

Leave as "Default” for normal use, or change it
CONYESION On Save required,

ADS Stream: I j

(&It Data Stream is only far fles on MTES drives)

A
= o
EEEEE TN amEwmBVeRad DEE; 0B ERL s

10. Return to the original firmware session, use the Browse button to locate the crt certificate file,
and click Upload to enable the certification.

A NEW DEFRATION OF HD Home Client settings ELLul'MeudlLE Language
Security > HTTPS

System

— HTTPS
Media [¥ Enahble HTTPS secure connection
Network = Mode:
i & HTTP & HTTPS { HTTPS only
User accounts e Certificate:
HTTPS Certificate information
Access list Status: Waiting for certificated
IEEE 802.1x Select certificate file: C\Documents and Se ?Emwse..é| Upload |
PTZ Method Create cerificate request and install
Event Country: T
. State or province: Asia
Applications
Locality: Asia
Recording Organization: VIVOTEK Inc
Local storage Organization unit: VIVOTEK Int
Comrmon harne: whai ivotek com

| Basic mode | Remove certificate |
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11. When the certifice file is successfully loaded, its status will be stated as Active. Note that
a certificate must have been created and installed before you can click on the “Save"
button for the configuration to take effect.

— HTTPS

[ Enable HTTPS secure connection

= Mode:

@ HTTP & HTTPS ¢ HTTPS only

w Cerificate:

Certificate information

Status: Active

Method: Create cedificate request and install
Country: T

State or pravince: Asia

Locality: Asia

Organization: WIVOTEK Inc.

Organization unit: YIVOTEK Inc.

Comman name: whner vivotek.com

Certificate properties Remaove cerificate |

Save |

12.To begin an encrypted HTTPS session, click Home to return to the main page. Change the URL
address from “http://” to “https://“ in the address bar and press Enter on your keyboard. Some
Security Alert dialogs will pop up. Click OK or Yes to enable HTTPS.

Security Alert X Security Information X
You are about to view pages over a secure connection, @ This page cortains both secure and nonsecure
. . L iterns.
Any information pou exchange with this site cannot be

iewed by | the ‘wWeb. . .
viEwWeEy anpane Slse an s e Do you want to digplay the nonsecure tems?

[ I the future, da nat show this warning

[ OK “ More Infa J i ‘Yes ” Mo ][ are Info J

Security Alert |X|

Information you exchange with thiz site cannot be viewed or
changed by others. However, there iz a problem with the site's
zecunty certificate.

The zecurity certificate was izsued by a3 company you have
not chosen to trust, Yiew the certificate to determine whether
you want b trust the certifying autharity.

° The secunty certificate date iz valid.

The name on the zecurnty certificate iz invalid or does not
rmatch the name of the site

Do wou want to proceed?

[ Yes J i Mo i ['V'iew Certificate J
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Security > Access List

This section explains how to control access permission by verifying the client PC’s IP
address.

General Settings

Maximum number of concurrent streaming: [ Connection management ]

|’ General settings

Maximum number of concurrent streaming connection(s) limited to: Simultaneous live viewing for
1~10 clients (including stream 1 to stream 3). The default value is 10. If you modify the value and
click Save, all current connections will be disconnected and automatically attempt to re-link (IE
Explorer or QuickTime Player).

View Information: Click this button to display the connection status window showing a list of the
current connections. For example:

IP address Elapsed time User ID
r 172.16.2.53 00:00:05

| 192.168.4.104 01:49:35

Refresh Add to deny list Disconnect Close

Note that only consoles that are currently displaying live streaming will be listed in the View
Information list.

m |IP address: Current connections to the Network Camera.
m Elapsed time: How much time the client has been at the webpage.

m User ID: If the administrator has set a password for the webpage, the clients have to enter a
user name and password to access the live video. The user name will be displayed in the User
ID column. If the administrator allows clients to link to the webpage without a user name and
password, the User ID column will be empty.

There are some situations that allow clients access to the live video without a user name and

password:

1. The administrator does not set up a root password. For more information about how to set up
a root password and manage user accounts, please refer to Security > User account on page
94.

2. The administrator has set up a root password, but set RTSP Authentication to “disable”. For
more information about RTSP Authentication, please refer to RTSP Streaming on page 84.

3. The administrator has set up a root password, but allows anonymous viewing. For more
information about Allow Anonymous Viewing, please refer to page 94.
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m Refresh: Click this button to refresh all current connections.

m Add to deny list: You can select entries from the Connection Status list and add them to the
Deny List to deny access. Please note that those checked connections will only be disconnected
temporarily and will automatically try to re-link again (IE Explorer or QuickTime Player). If you
want to enable the denied list, please check Enable access list filtering and click Save in the
first column.

m Disconnect: If you want to break off the current connections, please select them and click this
button. Please note that those checked connections will only be disconnected temporarily and
will automatically try to re-link again (IE Explorer or QuickTime Player).

Filter
Enable access list filtering: Check this item and click Save if you want to enable the access list
filtering function.

Filter type: Select Allow or Deny as the filter type. If you choose Allow Type, only those clients
whose |IP addresses are on the Access List below can access the Network Camera, and the others
cannot. On the contrary, if you choose Deny Type, those clients whose IP addresses are on the
Access List below will not be allowed to access the Network Camera, and the others can.

— Filter
Enable access list filtering
Filter type: ) Allow @ Deny

IPv4 access list

IPv6 access list

Then you can Add a rule to the following Access List. Please note that the IPv6 access list column
will not be displayed unless you enable IPv6 on the Network page. For more information about
IPv6 Settings, please refer to Network > General settings on page 76 for detailed information.
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There are three types of rules:
Single: This rule allows the user to add an IP address to the Allowed/Denied list.
For example:

Filter address

IF address:  192.168.2.1

[_ox [ cancel |

Network: This rule allows the user to assign a network address and corresponding subnet mask to
the Allow/Deny List. The address and network mask are written in CIDR format.
For example:

Filter address

Metwork address / Network mask: 19216820 | ! |24 |

ok ][ cancel |

IP address range 192.168.2.x will be bolcked.

If IPv6 filter is preferred, you will be prompted by the following window. Enter the IPv6 address and
the two-digit prefix length to specify the range of IP addresses in your configuration.

PAdd ipvb filter list

Filter address

Metwork address / Metwork mask: | | ! | |

[ ok [ cancel |

Range: This rule allows the user to assign a range of IP addresses to the Allow/Deny List.
Note: This rule only applies to IPv4 addresses.
For example:

Filter address

Rute:

IP address - IP address: | 102 168.2.0 | - | 192.168.2.255| |

ok J[ cancel |

Administrator IP address

Always allow the IP address to access this device: You can check this item and add the
Administrator’s IP address in this field to make sure the Administrator can always connect to the
device.

— Administrator IP address

Always allow the IP address to access this device |
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Security > IEEE 802.1X

Enable this function if your network environment uses IEEE 802.1x, which is a port-based network
access control. The network devices, intermediary switch/access point/hub, and RADIUS server
must support and enable 802.1x settings.

The 802.1x standard is designed to enhance the security of local area networks, which provides
authentication to network devices (clients) attached to a network port (wired or wireless). If all
certificates between client and server are verified, a point-to-point connection will be enabled; if
authentication fails, access on that port will be prohibited. 802.1x utilizes an existing protocol, the
Extensible Authentication Protocol (EAP), to facilitate communication.

m The components of a protected network with 802.1x authentication:

>
. ~»
Supplicant Authenticator Authentication Server
(Network Camera) (Network Switch) (RADIUS Server)

N

. Supplicant: A client end user (camera), which requests authentication.

2. Authenticator (an access point or a switch): A “go between” which restricts unauthorized end
users from communicating with the authentication server.

3. Authentication server (usually a RADIUS server): Checks the client certificate and decides

whether to accept the end user’s access request.

m VIVOTEK Network Cameras support two types of EAP methods to perform authentication: EAP-
PEAP and EAP-TLS.

Please follow the steps below to enable 802.1x settings:

1. Before connecting the Network Camera to the protected network with 802.1x, please apply
a digital certificate from a Certificate Authority (i.e., your network administrator) which can be
validated by a RADIUS server.

2. Connect the Network Camera to a PC or notebook outside of the protected LAN. Open the
configuration page of the Network Camera as shown below. Select EAP-PEAP or EAP-TLS as
the EAP method. In the following blanks, enter your ID and password issued by the CA, then
upload related certificate(s).

— IEEE 802.1x

Enable IEEE 802 1x

EAP method: EAP-FEAFR 1{1

Identity: |

Password: | |

CA certificate: | [ Browse.. || Upload
Status: nofile [ Remove |
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— IEEE 802.1x

Enable 802.1x

EAP method: EAP-TLS  »

|dentity:

|
Private key passord: | |
|

CA certificate: [ Browse.. || Upload
Status: no file [ Remove |
client certificate: | [ Browse.. || Upload
Status: nofile [ Remove |
Client private key: | [ Browse.. || Upload
Status: nofile [ Remove |

3. When all settings are complete, move the Network Camera to the protected LAN by connecting
it to an 802.1x enabled switch. The devices will then start the authentication automatically.

/) NOTE:

» The authentication process for 802. 1x:

1. The Certificate Authority (CA) provides the required signed certificates to the Network Camera
(the supplicant) and the RADIUS Server (the authentication server)

2. A Network Camera requests access to the protected LAN using 802.1X via a switch (the
authenticator). The client offers its identity and client certificate, which is then forwarded by the
switch fo the RADIUS Server, which uses an algorithm to authenticate the Network Camera and
returns an acceptance or rejection back to the switch.

3. The switch also forwards the RADIUS Server's certificate to the Network Camera.

4. Assuming all certificates are validated, the switch then changes the Network Camera’s state to
authorized and is allowed access fo the protected network via a pre-configured port.

Certificate Authority
(CA)

Certificate Certificate

9
it o [N

VIVOTEK h:’ Network Switch RADIUS Server

Network Camera

Protected LAN
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Security > Miscellaneous

The embedded TrendMicro utitlity provides the protection against Cross-Site Request
Forgery. Cross-site request forgery is also known as one-click attack or session riding and
is abbreviated as CSRF. CSRF is a type of malicious exploit of a website, in this case, the
camera. Unauthorized commands are transmitted from a user that the web application
trusts, using the mechanism of forging a trusted user's own request with a request
containing his own cookies, etc. Different ways can be used for a malicious website to
transmit such commands. They can be specially-crafted image tags, hidden forms, and
JavaScript XMLHttpRequests. The malicious attack can occur without users' interaction or
even knowing it.

— Miscellaneous

Enable Cross-Site Request Forgery(CSRF) protection.

We strongly recommend not to disable this protection. Disabling this feature will expose your
camera to risks.
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PTZ > PTZ settings

This section explains how to control the Network Camera’s Pan/Tilt/Zoom operation.

Digital: Control the e-PTZ operation. Within a field of view,it allows users to quickly move the
focus to a target area for close-up viewing without physically moving the camera.

Digital PTZ Operation (E-PTZ Operation)

The e-PTZ control settings section will be displayed as shown below:

Digital

Selectstream: 1 =
2015/05/20 09:57:30
, s [« ][ Home J[» |
om [
Pan speed: [ 4
Tilt speed: o -
Zoom speed: [ ¢
Auto pan/patrol speed: 1 =
Go to:
— Selectone - -
— Home locatiom setiings
| selcurentposiionashome | | Resbrehome positionts default
— Preset and patrol settings
Name:| Add preset location Select Preset Locations for Patrol
User preset locations Patrol locations Ml(l::';
lower left i upper left 5 -
center et 5 B
right B B owerter 5
upper right center 5
lower right 3 right 5 4
L]'m“ [ Remove ] [Ilure]
— Misc settings
Zoom factor display
- Sawe

For e-PTZ related details, please refer to page 110.

Auto pan/patrol speed: Select the speed from 1~5 (slow/fast) to set up the Auto pan/patrol speed control.

Zoom factor display

If you check this item, the zoom indicator will be displayed on the home page when you zoom in/out the
live viewing window as the picture shown on the next page.

When completed with the e-PTZ settings, click Save to enable the settings on this page.
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Home page in the E-PTZ Mode

* viverzk CC9381-HV

wwwwwwwwwwwwww

Video stream: [1 [v] ient settings | Configuration | Language
% Manual triggers: = - —

— . ' i

Pan speed: |o .
Tilt speed: |o .

Move Instantly

= E@WE’

m The e-Preset Positions will also be displayed on the home page. Select one from the drop-down
list, and the Network Camera will move to the selected position.

m If you have set up different preset positions for different streams, you can select one of the video
streams to display its separate preset positions.

Global View

In addition to using the e-PTZ control panel, you can also use the mouse to drag or resize the
floating frame to pan/tilt/zoom the viewing region. The live view window will also move to the
viewing region accordingly.

Moving Instantly

If you check this item, the live view window will switch to the new viewing region instantly after you
move the floating frame. If not selected, the process of moving from one position to another will be
shown.

Click on Image
The e-PTZ function also supports “Click on Image®“. When you click on any point of the Global View
Window or Live View Window, the viewing region will also move to that point.

Note that the’Click on Image” function only applies when you have configured a smaller “Region
of Interest” out of the maximum output frame! e.g., an 800 x 600 region from out of the camera’s
maximum frame size.

Patrol button: Click this button, then the Network Camera will patrol among the selected preset
positions continuously.
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Patrol settings

You can select some preset positions for the Network Camera to patrol.
Please follow the steps below to set up a patrol schedule:

. Select the preset locations on the list, and click [»].
. The selected preset locations will be displayed on the Patrol locations list.

. Set the Dwelling time for the preset location during an auto patrol.

. If you want to delete a preset location from the Patrol locations list, select it and click Remove.

. Select a location and click [ a | [ ¥] to rearrange the patrol order.

. Select patrol locations you want to save in the list and click Save to enable the patrol settings.

. To implement the patrol schedule, please go to homepage and click on the Patrol button. Please refer
to the next page.

ot

NOoO o~ OWN-

Selectstream:
( 2017/3/20 09:57:30 II'
@ | | Home [ » |
] zom
Fan speed:
Tilt speed:
Zoom speed: 0 w
Auto panfpafrol speed: L
Go foc
-- Selectone -- ~
— Home location settings
Setcurent position as home | | Resiore home position to default |
— Preset and patrol settings e e
Name: | Add preset location Select Preset Locations for Patrol
n User preset locations [] Patrol locations II Dwell(g::;
upper left A [] upperleft 5 A
left [] left 5
lower left [ lowerleft 5
center [] center 5
) W
right [] right 5 W
ore] | [renoe [4]7]
— Misc settings n E
Zoom factor display @
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» The Preset Positions will also display on the Home page. Select one from the Go to menu, and the
Network Camera will move to the selected position.
» Click Patrol: The Network Camera will patrol along the positions repeatedly.
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Event > Event settings

This section explains how to configure the Network Camera to respond to particular situations
(event). A typical application is that when a motion is detected, the Network Camera sends
buffered images to an FTP server or e-mail address as notifications. Click on Help, there is
an illustration shown in the pop-up window explaining that an event can be triggered by many

sources, such as motion detection or external devices connected via the digital input wires.
When an event is triggered, you can specify what type of action that will be performed. You can
configure the Network Camera to send snapshots or videos to your email address or FTP site.

Event
Hame Status Sun Mon Tue Wed Thu Fri Sat Time Trigger
Add | Hetp
close or EscKey

Event Trigger — Action (What to do)

Motion detection, Periodically,
Digital input, System boot

Media (What to send) Server (Where to send)

Ex

Snapshot, Video Clip, System log Email, FTP, HTTP Server,
Metwork storage

Event

To configure an event with reactive measures such as recording video or snapshots, it is necessary to
configure the server and media settings so that the Network Camera will know what action to take (such
as which server to send the media files to) when a trigger is activated. An event is an action initiated by a
user-defined trigger source. In the Event column, click Add to open the event settings window. Here you
can arrange three elements -- Schedule, Trigger, and Action to set an event. A total of 3 event settings
can be configured.

Event

Hame Status Sun Mon Tue Wed Thu Fri Sat Time Trigger

[ Ass  Jted

Event name:| |

Enable this event

Prierity: Normal [«
Detect next motion detection or digital input aﬁersecond(s]

" Event Schedul
[¥] Sun [¥] Mon [¥] Tue [¥] Wed [¥] Thu [¥] Fri [#] Sat

Time

1. Schedule

l @ Always

© From to[hh mm]

2. Trigger

3. Action

Save event ] [ Close ]
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m Event name: Enter a name for the event setting.
m Enable this event: Select this option to enable the event setting.

m Priority: Select the relative importance of this event (High, Normal, or Low). Events with a higher
priority setting will be executed first.

m Detect next event after [] seconds: Enter the duration in seconds to pause motion detection after
a motion is detected. This can prevent event-related actions to take place too frequently.

1. Schedule

Specify the period of them during which the event trigger will take effect. Please select the days of the
week and the time in a day (in 24-hr time format) for the event triggering schedule. For example, you
may prefer an event to be triggered only during the off-office hours.

2. Trigger

This is the cause or stimulus which defines when to trigger the Network Camera. The trigger source can
be configured to use the Network Camera’s built-in motion detection mechanism or external digital input
devices.

There are several choices of trigger sources as shown on the next page. Select the item to display the
detailed configuration options.

m Video motion detection
This option makes use of the built-in motion detection mechanism as a trigger source. To enable this
function, you need to configure a Motion Detection Window first. For more information, please refer to
Motion Detection on page 126 for details.

Mormal: doar

Profile: hallway

Maote: Please cunﬁgurei Motion detection first

m Periodically
This option allows the Network Camera to trigger periodically for every other defined minute. Up to 999
minutes are allowed.

Trigger every ather minutes
m System boot

This option triggers the Network Camera when the power to the Network Camera is disconnected and
re-connected.

m Recording notify
This option allows the Network Camera to trigger when the recording disk is full or when recording
starts to overwrite older data.

m Audio detection
A preset threshold can be configured with an external microphone as the trigger to system event. The
triggering condition can be an input exceeding or falling below a threshold. Audio detection can take
place as a complement to motion detection or as a method to detect activities not covered by the
camera's view.
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m Camera tampering detection
This option allows the Network Camera to trigger when the camera detects that is is being tampered
with. To enable this function, you need to configure the Tampering Detection option first. Please refer
to page 129 for detailed information.

Camera tampering detection

[[] Tampering detection

Trigger duration seconds [10~600]
Trigger treshold [0~100]

[[] Image too dark detection

m Manual Triggers
This option allows users to enable event triggers manually by clicking the on/off button on the
homepage. Please configure 1 to 3 associated events before using this function.

-
L1
....... R, W Y DT e, S

CO1E2E2 WdeuShean
= Manual Trigger:
4| on]
2| 0n]
3| on

m VADP

It is presumed that you already uploaded and enabled the VADP modules before you can associatee
VADP triggers with an Event setting.

Click on the Set VADP Trigger button to open the VADP setup menu. The triggering conditions
available with 3rd-party software modules known as VADP will be listed. Use the arrow buttons to
select these triggers. Users may implant these modules for different purposes such as triggering
motion detection, or applications related to video analysis, etc. Please refer to page 132 for the
configuration options with VADP modules.

Set VADP Trigger

VADP Triggers Triggers for Event Settings

ManualTrigger
Triggerh
Triggerd
TriggerC

TriggerD

[ Close Il Save
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Once the triggers are configured, they will be listed under the VADP option.

@ VADP

TriggerD
TriggerA
TriggerB
TriggerC

J Set VADP Trigger

ManualTrigger TriggerD
TriggerA
TriggerB

TriggerC

[ Close J[ sae |

3. Action
Define the actions to be performed by the Network Camera when a trigger is activated.

— Action

Backup media ifthe network is disconnected

Server Media Extra parameter
0 | —None—=] SDiest View
HTTP  —None— =]

L Create folders by date time and hour automatically
nas —Mone— | =

Addserver &)  Add media &)

m Push notification
The event message will be sent to the VIVOCloud application on your cell phone.

m Trigger digital output for [ ] seconds
Select this option to turn on the external digital output device when a trigger is activated. Specify

the length of the trigger interval in the text box.

m Backup media if the network is disconnected
Select this option to backup media file on SD card if the network is disconnected. This function
will only be displayed after you set up a network storage (NAS). The media to back up can
include snapshot images, video, or system logs depending on your event settings.
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Add server

It is necessary to configure the server and media settings so that the Network Camera will know what
action to take (such as which server to send the media files to) when a trigger is activated. Click Add
server to open the server setting window. You can specify where the notification messages are sent to
when a trigger is activated. A total of 5 server settings can be configured.

There are four choices of server types available: Email, FTP, HTTP, and Network storage. Select the item
to display the detailed configuration options. You can configure either one or all of them.

| Add server | ‘ Add media O‘

Server name: | Email

Server type

@ Email
Sender email address: |Camera@\ﬂmtekcom |
Recipient email address: |recipient@\nvotekcom |
Sernver address: | Ms.vivotek.tw |

—

This server requires a secure connection
) FTP
) HTTP

Metwoark storage

Test ” Save senver ” Close

Server type - Email
Select to send the media files via email when a trigger is activated.

m Server name: Enter a name for the server setting.

m Sender email address: Enter the email address of the sender.

m Recipient email address: Enter the email address of the recipient.

m Server address: Enter the domain name or IP address of the email server.

m User name: Enter the user name of the email account if necessary.

m Password: Enter the password of the email account if necessary.

m Server port: The default mail server port is set to 25. You can also manually set another port.

If your SMTP server requires a secure connection, select This server requires a secure connection.
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To verify if the email settings are correctly configured, click Test. The result will be shown in a pop-up
window. If successful, you will also receive an email indicating the result.

3 hitp://192.168.5 121icgi-binfad minftestserver cgi - - [ || 1 |[X)

2 http:4/192.168.5.121/cgi-binjedminftestserver.cgi - ... [ ]|01[%K]

The email hag been sent successfully. Error in sending email.

Click Save server to enable the settings.

Note that after you configure the first event server, the new event server will automatically display on the
Server list. If you wish to add other server options, click Add server.

Server WMedia Extra parameter
P o (=] shist i
Email | —None— [+]

||Mllsanmr (v ) ” Add media O‘
—

Server type - FTP
Select to send the media files to an FTP server when a trigger is activated.

Server name: | FTP |

Server Type

) Email

@ FTP
Server address: | ftp.vivotek.com
Server port
User name:
Password:

FTP folder name: |

Passive mode
) HTTP

) Network storage

m Server name: Enter a name for the server setting.
m Server address: Enter the domain name or IP address of the FTP server.

m Server port: By default, the FTP server port is set to 21. It can also be assigned to another port number
between 1025 and 65535.

m User name: Enter the login name of the FTP account.
m Password: Enter the password of the FTP account.

m FTP folder name

Enter the folder where the media files will be placed. If the folder name does not exist, the Network
Camera will automatically create one on the FTP server.

122 - User's Manual




VIVOTEK

m Passive mode

Most firewalls do not accept new connections initiated from external requests. If the FTP server
supports passive mode, select this option to enable passive mode FTP and allow data transmission to
pass through the firewall. The firmware default has the Passive mode checkbox selected.

To verify if the FTP settings are correctly configured, click Test. The result will be shown in a pop-up
window as shown below. If successful, you will also receive a test.txt file on the FTP server.

2 hitp:i/192.168.5 121 /egi-binfadminftestserver.ezi- ... [ | 0 |[K] A hiip://192.168 5121 jcgi- binfadminfiesteerver.cgi - .. [ 1 |[3€)

fip transmission successfully. ftp transmission failed.

Click Save server to enable the settings.

Server type - HTTP
Select to send the media files to an HTTP server when a trigger is activated.

Server name: | HTTP |

Server Type
) Email
@ FTP

@ HTTP

URL: |nnp:m 92.168.5.10/cgi-binfupload.cqi

) Metwork storage

[ Test || saveserver || Close

m Server name: Enter a name for the server setting.
m URL: Enter the URL of the HTTP server.
m User name: Enter the user name if necessary.

m Password: Enter the password if necessary.

To verify if the HTTP settings are correctly configured, click Test. The result will be shown in a pop-up
window as shown below. If successful, you will receive a test.ixt file on the HTTP server.

2 hitp://192.168.5.121/c gi-bin/ad minftestserver.czi - ... [0 L1)(X)

3 hitp:£1192 1685 121 fegi-binfad minfiestserver.coi - . |T|

HTTP Transmission successfully. Thanks HTTP Transmission failed.

Click Save server to enable the settings.
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Network storage:
Select to send the media files to a networked storage when a trigger is activated. Please refer to NAS
server on page 138 for details. Note that only one NAS server can be configured.

Click Save server to enable the settings.

— Action

Backup media if the netwoark is disconnected

Server Media Extra parameter
© | —tone— (o] spest i
Email  —Mone—[=]
FTP | —None— [+
HTTP | —None— =]

Create folders by date time and hour automatically

7 s

‘ Add server O|| Add media O‘

View

m SD Test: Click to test your SD card. The system will display a message indicating the result as a
success or a failure. If you want to use your SD card for local storage, please format it before use.
Please refer to page 121 for detailed information.

m View: Click this button to open a file list window. This function applies only to SD card and networked
storage. If you click the View button for an SD card, a Local storage page will prompt so that you can
manage the recorded files on gqn SD card. For more information about Local storage, please refer to
page 140. If you click the View button for a Network storage, a file directory window will prompt for you
to view recorded data on Network storage. For detailed illustration, please refer to the next page.

m Create folders by date, time, and hour automatically: If you select this item, the system will
automatically create folders by the date when video footages are stored onto the networked storage.

The following is an example of a file destination with video clips:

[] #/]20170120 The format is: YYYYMMDD
[] 520170121 Click to open the directory

[] 20170122

[ Delete | [ Deleteal |——Click to delete all recorded data

Click to delete selected items
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Click 20170120 to open the directory:

The format is: HH (24r)
Click to open the file list for that hour

< 07 03 09 10 11 12 13 14 15 16 17 =

file name Size date time
[]|Recordingl 58.mp4| 2526004 2017/01/20 07/58)28
[]|Recordingl 59.mp4 2563536 2017/01/20 075928

| DelletE | | Deleteal | | Back |

1
Click to delete Click to go back to the previous
selected items level of the directory

Click to delete all
recorded data

< 07 03 09 10 11 12 13 14 15 16 17 =

file name | size date time
[]|Recording1 5ﬂ.mpA| 2526004 2017/01/20 07:58:28
[]|Recordingl 59.mﬂ| 2563536 2017/01/20 07:59:28

[ Delete | [ Deleteall | | Back |

The format is: File name prefix + Minute (mm)
You can set up the file name prefix on Add media page. Please
refer to next page for detailed information.
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Add media

Click Add media to open the media setting window. You can specify the type of media that will be
sent when a trigger is activated. A total of 5 media settings can be configured. There are three choices
of media types available: Snapshot, Video Clip, and System log. Select the item to display the detailed
configuration options. You can configure either one or all of them.

Add server &0 | Add media

— Media type
Aftached media:

@ Snapshot

Send pre-event image(s) [0~7]
send post-eventimage(s) [0~7]

File name prefix: |Sn apshot_

) Video clip

) Bystem log

Savemedia | |  Close

Media type - Snapshot
Select to send snapshots when a trigger is activated.

m Media name: Enter a name for the media setting.
m Source: Select to take snapshots from any of the video streams.

m Send [] pre-event images
The Network Camera has a buffer to temporarily hold data up to a certain limit. Enter a number to
decide how many images to capture before a trigger is activated. Up to 7 images can be generated.

m Send [ ] 